Specifying a name for the BlackBerry Administration Service pool during the installation process........................................62
Upgrade the BlackBerry Enterprise Server instances that you configured for disaster recovery........................................62

7 Upgrading the BlackBerry Enterprise Server using the cutover upgrade process and upgrading the existing BlackBerry Configuration Database ........................................................................................................... 64
Upgrade a BlackBerry Configuration Database.................................................................................................................. 65
BESMgmt.cfg properties ........................................................................................................................................................ 65
Install the BlackBerry Enterprise Server on a new computer and upgrade the existing BlackBerry Configuration Database ... 66
Specifying a name for the BlackBerry Administration Service pool during the installation process................................68
Move user accounts to a new BlackBerry Enterprise Server using the BlackBerry Administration Service .........................69
Prevent the previous BlackBerry Enterprise Server from connecting to the BlackBerry Infrastructure..............................70
Start the new BlackBerry Enterprise Server ......................................................................................................................70

8 Upgrading the BlackBerry Enterprise Server using the cutover upgrade process and creating a BlackBerry Configuration Database .......................................................................................................................... 71
Create a BlackBerry Configuration Database ..................................................................................................................... 72
BESMgmt.cfg properties ........................................................................................................................................................ 72
Install the BlackBerry Enterprise Server on a new computer and create a BlackBerry Configuration Database ............73
Specifying a name for the BlackBerry Administration Service pool during the installation process............................75

9 Upgrading the BlackBerry Enterprise Server software in phases ................................................................................. 77
Upgrade multiple BlackBerry Enterprise Server instances in phases .............................................................................78
Upgrade a standalone BlackBerry Router ..........................................................................................................................79
Test the connection from the BlackBerry Router to the BlackBerry Infrastructure ............................................................79

10 Postupgrade tasks........................................................................................................................................................... 80
Resend the database mirroring parameters to BlackBerry Enterprise Server components .............................................. 80
Restore the BlackBerry MDS Connection Service configuration files ........................................................................ 81
Upgrade the BlackBerry database notification system ................................................................................................... 81
Best practice: Running the BlackBerry Enterprise Server ................................................................................................... 82
Configuring support for Unicode languages ..................................................................................................................... 83
Configure support for Unicode languages ........................................................................................................................ 83
Change the character encoding that the BlackBerry Enterprise Server uses to send Unicode messages ...................... 84
Configure the BlackBerry Enterprise Server to use only UTF-8 to send Unicode messages .......................................... 85
Configure support for Unicode text in calendars on BlackBerry devices in a Microsoft Exchange environment ........... 85
Configuring the BlackBerry Enterprise Server to use Microsoft Exchange Web Services .............................................. 86
Prerequisites: Configuring the BlackBerry Enterprise Server to use Microsoft Exchange Web Services ...................... 87
Configure the BlackBerry Enterprise Server to use Microsoft Exchange Web Services ............................................... 87
Manage the BlackBerry Enterprise Server performance in a Microsoft Exchange 2010 environment ............................. 88
Configure a Hosted BlackBerry services environment for use with Microsoft Exchange 2010 SP1 Multi-Tenant Deployment ........................................................................................................................................... 89
Configure the BlackBerry Administration Service instances in a pool to communicate across network subnets ............ 89
Log in to the BlackBerry Administration Service for the first time .................................................................................. 90
Troubleshooting the BlackBerry Enterprise Server upgrade process........................................... 99
Failed to write License Key to the Database................................................................................ 99
Previous version detected but no database available........................................................................ 99
You encounter errors when you try to upgrade the BlackBerry Configuration Database.................. 100
You cannot resolve errors that occur when you move users ......................................................... 100
A third-party tool did not install and the BlackBerry Enterprise Server setup application closed .......... 101
The BlackBerry Collaboration Service does not connect to Microsoft Office Live Communications Server 2005................................................................. 101
The setup application did not prompt you to change or confirm the MAPI profile.......................... 102
Restore a BlackBerry Configuration Database.................................................................................. 102
Users experience unexpected behavior with message lists and calendars on BlackBerry devices.......... 103
Some BlackBerry Enterprise Server components do not start......................................................... 104
You cannot access the BlackBerry Administration Service............................................................ 105
You cannot create a user account in the BlackBerry Administration Service.................................. 105
The BlackBerry Administration Service pool name is the same as the FQDN of the host computer.... 106
You cannot add users in the BlackBerry Administration Service after an upgrade to BlackBerry Enterprise Server 5.0 SP4.106

Related resources..........................................................................................................................109
Glossary........................................................................................................................................110
Legal notice.....................................................................................................................................112
Overview: BlackBerry Enterprise Server

The BlackBerry Enterprise Server is designed to be a secure, centralized link between an organization's wireless network, communications software, applications, and BlackBerry smartphones. The BlackBerry Enterprise Server integrates with your organization's existing infrastructure to provide smartphone users with mobile access to your organization's resources.

You can manage the BlackBerry Enterprise Server, smartphones, and user accounts using the BlackBerry Administration Service. You can access the BlackBerry Administration Service web application from any computer that can access the computer that hosts the BlackBerry Administration Service.

You can optionally install BlackBerry Management Studio in your organization's environment to provide a simplified administrative console for your organization's helpdesk administrators and an integrated view of the BlackBerry Enterprise Server and other MDM domains. For more information, visit http://www.blackberry.com/go/serverdocs to see the BlackBerry Management Studio Feature and Technical Overview.
Planning a BlackBerry Enterprise Server

If your organization’s environment includes only one BlackBerry Enterprise Server that is version 5.0 SP2 or later, you can upgrade the BlackBerry Enterprise Server to the latest version by overwriting it or by installing it on a different computer and moving the user data to the upgraded BlackBerry Enterprise Server.

If your organization’s environment includes more than one BlackBerry Enterprise Server that is version 5.0 SP2 or later, you can upgrade each BlackBerry Enterprise Server instance to the latest version in phases to reduce the risk to your organization’s environment and minimize the number of users that the upgrade might affect at the same time.

If mirroring is enabled in your organization's environment, you must run on the primary database to perform an upgrade. Upgrades are not supported when running in a mirrored failover state.

For information about upgrading more than one BlackBerry Enterprise Server, see the BlackBerry Enterprise Server Upgrade Planning Guide.

Supported BlackBerry Enterprise Server versions that you can upgrade

You can upgrade the following BlackBerry Enterprise Server versions to the latest version:

- BlackBerry Enterprise Server 5.0 SP2
- BlackBerry Enterprise Server 5.0 SP3
- BlackBerry Enterprise Server 5.0 SP4

If your organization has a BlackBerry Enterprise Server version that is not listed, you must first upgrade to one of the BlackBerry Enterprise Server versions in the list above before you can upgrade to the latest version.
Replacing the BlackBerry Manager with the BlackBerry Administration Service

In BlackBerry Enterprise Server versions later than version 4.1, the BlackBerry Administration Service replaces the BlackBerry Manager as the BlackBerry Enterprise Server component that you use to manage the BlackBerry Enterprise Server and BlackBerry device users.

During the BlackBerry Enterprise Server upgrade process, the setup application removes the BlackBerry Manager. If you installed a standalone BlackBerry Manager, you can remove the BlackBerry Manager after you install the BlackBerry Administration Service.

After the BlackBerry Enterprise Server upgrade process completes, you must create administrator accounts for the administrators in your organization and provide the administrators with new login information and the BlackBerry Administration Service web address. If you try to run the BlackBerry Manager, it displays the "DB version greater than maximum currently supported" message and closes.

Removing the BlackBerry Monitoring Service

If you have previously installed the BlackBerry Monitoring Service, it will no longer function after you upgrade to BlackBerry Enterprise Server 5.0 Service Pack 4. Depending on where the BlackBerry Monitoring Service is installed, you will have to perform one of the following actions during the installation:

- If the BlackBerry Monitoring Service is currently installed on the same computer as at least one other BlackBerry Enterprise Server component, the installation setup application will detect that the BlackBerry Monitoring Service is installed on the computer and the setup application will prompt you to remove it.

- If the BlackBerry Monitoring Service is installed on a separate computer, the setup application will display a message that the BlackBerry Monitoring Service is no longer in production and cannot be used after you upgrade to BlackBerry Enterprise Server 5.0 Service Pack 4.

- If a standalone instance of the BlackBerry Monitoring Service is installed on the computer where you are installing BlackBerry Enterprise Server 5.0 Service Pack 4, the setup application will display a message that the BlackBerry Monitoring Service is no longer in production and you can remove it using Add or Remove Programs.
Upgrade implications for the BlackBerry Configuration Database

When you upgrade the BlackBerry Enterprise Server to the latest version, you must also upgrade the BlackBerry Configuration Database to the latest version. You can use the setup application to install or upgrade BlackBerry Enterprise Server components such as the BlackBerry Configuration Database. The installation or upgrade process upgrades the BlackBerry Configuration Database automatically so that the database and components run the same version. If you do not want to use the setup application to upgrade the BlackBerry Configuration Database, you can run the database upgrade scripts on the database server.

You cannot manage the BlackBerry Enterprise Server until you install the BlackBerry Administration Service version that is the same as the BlackBerry Configuration Database version or upgrade the BlackBerry Administration Service so that it is the same version as the BlackBerry Configuration Database.

You must move an MSDE database such as a BlackBerry Configuration Database from MSDE to a version of Microsoft SQL Server that Microsoft fully supports. To upgrade a BlackBerry Configuration Database and move it from MSDE to Microsoft SQL Server, you must create a copy of the BlackBerry Configuration Database, move the copy to Microsoft SQL Server, and then upgrade the BlackBerry Configuration Database on the Microsoft SQL Server to the latest version.

Synchronizing data over the wireless network automatically

When you upgrade the BlackBerry Enterprise Server, the BlackBerry Synchronization Service sends updated service books to the BlackBerry devices that can synchronize data over the wireless network. BlackBerry Device Software versions 4.0 and later can synchronize data automatically if the BlackBerry Enterprise Server is running.

If the data does not synchronize automatically, you must use the BlackBerry Administration Service to resend the service books and synchronize the data.

Corrective calendar synchronization

Corrective calendar synchronization finds and corrects differences between the calendar entries on BlackBerry devices and the calendar entries on users’ computers.
When you upgrade the BlackBerry Enterprise Server to the latest version, corrective calendar synchronization is turned on by default. Corrective calendar synchronization is configured to run daily at 12:00 AM for all users whose devices are turned on. It checks users’ calendars to correct any differences that display for the next seven days between calendars on devices and calendars in email applications. For more information about corrective calendar synchronization and changing the default settings, see the BlackBerry Enterprise Server Administration Guide.

Upgrade application for BlackBerry Enterprise Server

You can install or upgrade the BlackBerry Enterprise Server, including service packs, by running the setup application. You can also upgrade the BlackBerry Enterprise Server to a service pack by running the upgrade application for BlackBerry Enterprise Server, which is available for download from www.blackberry.com/support.

If the BlackBerry Configuration Database in the BlackBerry Enterprise Server domain is version 5.0 SP2 or 5.0 SP3, you can use the upgrade application for BlackBerry Enterprise Server 5.0 SP4 to perform any of the following tasks:

- upgrade a BlackBerry Enterprise Server that is version 5.0 SP2 or 5.0 SP3 to version 5.0 SP4
- install a BlackBerry Enterprise Server or BlackBerry Enterprise Server components on a computer in the BlackBerry Enterprise Server domain that does not already host a BlackBerry Enterprise Server instance or component

If the BlackBerry Configuration Database in the BlackBerry Enterprise Server domain is earlier than version 5.0 SP2, you cannot use the upgrade application for BlackBerry Enterprise Server 5.0 SP4. You must upgrade the BlackBerry Enterprise Server by running the setup application.

Upgrading the BlackBerry Enterprise Server if your organization's environment includes BlackBerry Mobile Voice System 4.6

The BlackBerry Mobile Voice System 4.6 can work with several versions of the BlackBerry Enterprise Server. If the BlackBerry MVS supports the version that you want to upgrade the BlackBerry Enterprise Server to, you can use one of the following upgrade processes:

- in-place upgrade process
- cutover process that upgrades a BlackBerry Configuration Database
• cutover process that creates a BlackBerry Configuration Database

If you use the in-place upgrade process, the BlackBerry MVS is not available to BlackBerry device users during the upgrade process. When the in-place upgrade process is complete, the BlackBerry MVS resumes automatically.

If you use a cutover process to upgrade the BlackBerry Enterprise Server, you must perform several additional actions before the BlackBerry MVS is available to users. For more information, visit www.blackberry.com/btsc to read article KB21108.
Hardware requirements: BlackBerry Enterprise Server

The following are requirements for a BlackBerry Enterprise Server and the BlackBerry Enterprise Server components that you install on a single computer, and excludes the BlackBerry Collaboration Service. The requirements are for a BlackBerry Enterprise Server environment that includes users that receive 100 to 200 email messages each day.

You can improve the performance and reliability of the BlackBerry Enterprise Server by installing the BlackBerry Enterprise Server components on multiple computers. If your BlackBerry Enterprise Server environment supports up to 1000 users, install the BlackBerry Configuration Database on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server. If your BlackBerry Enterprise Server environment supports up to 2000 users, install the BlackBerry Configuration Database and the BlackBerry Administration Service on computers that are separate from the computer that hosts the BlackBerry Enterprise Server.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| BlackBerry Enterprise Server that supports up to 200 users | • Single processor, 2.0 GHz Intel Xeon (two processors recommended)  
• 2 GB of memory  
• 64-bit operating system: Two 64 GB drives (minimum), RAID 1  
• 32-bit operating system: Two 36 GB drives (minimum), RAID 1  
• 150 MB disk space for the BlackBerry Enterprise Server  
• 400 MB disk space for the BlackBerry Administration Service  
• Approximately 2 MB per user each day for log files (100 email messages per user) |
| BlackBerry Enterprise Server that supports up to 500 users | • Two processors, 2.0 GHz Intel Xeon  
• 2 GB of memory  
• 64-bit operating system: Two 64 GB drives (minimum), RAID 1  
• 32-bit operating system: Two 36 GB drives (minimum), RAID 1  
• 150 MB disk space for the BlackBerry Enterprise Server  
• 400 MB disk space for the BlackBerry Administration Service  
• Approximately 2 MB per user each day for log files (100 email messages per user) |
<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| BlackBerry Enterprise Server that supports up to 1000 users         | • Two processors, 2.0 GHz Intel Xeon  
• 3 GB of memory  
• 64-bit operating system: Two 64 GB drives (minimum), RAID 1  
• 32-bit operating system: Two 36 GB drives (minimum), RAID 1  
• 150 MB disk space for the BlackBerry Enterprise Server  
• 400 MB disk space for the BlackBerry Administration Service  
• Approximately 2 MB per user each day for log files (100 email messages per user) |
| BlackBerry Enterprise Server that supports up to 2000 users          | • Two processors, 2.8 GHz Intel Xeon or two processors, 1.86 GHz Intel Xeon 5100 Series (Dual Core)  
• 4 GB of memory  
• 64-bit operating system: Two 64 GB drives (minimum), RAID 1 or four 64 GB drives (minimum), RAID 1+0  
• 32-bit operating system: Two 36 GB drives (minimum), RAID 1 or four 36 GB drives (minimum), RAID 1+0  
• 150 MB disk space for the BlackBerry Enterprise Server  
• 400 MB disk space for the BlackBerry Administration Service  
• Approximately 2 MB per user each day for log files (100 email messages per user) |
System requirements

For information about calculating hardware requirements, visit [www.blackberry.com/go/serverdocs](http://www.blackberry.com/go/serverdocs) to see the *BlackBerry Enterprise Server Capacity Calculator* and *BlackBerry Enterprise Server Performance Benchmarking Guide*. 

## System requirements: BlackBerry Enterprise Server

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>operating system</td>
<td>Any of the following operating systems:</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 R2 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2 SP1</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2012</td>
</tr>
<tr>
<td>Microsoft Exchange system tools</td>
<td>Any of the following system tools:</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Exchange 2003 SP2 System Manager</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Exchange Server MAPI Client and CDO 1.2.1</td>
</tr>
<tr>
<td></td>
<td>To support Microsoft Exchange Server 2010, you must install version 6.5.8211.0 or later of the Microsoft Exchange Server MAPI Client and CDO 1.2.1.</td>
</tr>
<tr>
<td></td>
<td>For more information about installing MAPI and CDO patches on your organization's BlackBerry Enterprise Server, visit <a href="http://support.microsoft.com">support.microsoft.com</a> to read article 917481 and visit <a href="http://www.blackberry.com/go/kbhelp">www.blackberry.com/go/kbhelp</a> to read article KB15779.</td>
</tr>
<tr>
<td>Microsoft Exchange organization of the system tools for the messaging server</td>
<td>The same Microsoft Exchange organization that the messaging server uses</td>
</tr>
</tbody>
</table>
## System requirements: BlackBerry Administration Service and BlackBerry Web Desktop Manager

The following system requirements apply to the computer that you install the BlackBerry Administration Service and BlackBerry Web Desktop Manager on.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDO library</td>
<td>To support the latest version of Microsoft Exchange Server in your organization’s environment, the latest version of the CDO library that applies to the Microsoft Exchange Server version</td>
</tr>
</tbody>
</table>
| Unicode support for calendars | To support Microsoft Exchange Server 2003, the following Microsoft hotfixes:  
  • 913643 on the messaging server  
  • 923537 on the computer that hosts the BlackBerry Enterprise Server |
| static IP address for the computer | To install the BlackBerry Administration Service in a pool, a static IP address for the computer that hosts the component |
| browser                       | Windows Internet Explorer 7.0 to 8.0 with language preferences configured to display encoded web pages |
| media player                  | One of the following:  
  • if using Windows Server 2008, to support audio attachments, Windows Media Format SDK (for more information, visit [msdn.microsoft.com](https://msdn.microsoft.com) and search Windows Media Format SDK)  
  • if using Windows Server 2003, to support audio attachments, Windows Media Player 9 or later |
| network proximity             | A high-speed, switched connection between the BlackBerry Enterprise Server and messaging servers |
| File and Printer Sharing      | If using Windows Server 2003, to permit the BlackBerry Controller to monitor BlackBerry Enterprise Server components, install File and Printer Sharing  
  For more information, see the documentation for Windows Server |
### System requirements: BlackBerry Enterprise Server databases

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>database management system</td>
<td>Any of the following database management systems:</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2005 SP3 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2005 SP4 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2005 Express SP3</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2008 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2008 SP3 (32-bit or 64-bit)</td>
</tr>
<tr>
<td>Item</td>
<td>Requirement</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>collation setting</td>
<td>To configure collation settings, the following conditions:</td>
</tr>
<tr>
<td></td>
<td>• database server collation configured to default case-insensitive</td>
</tr>
<tr>
<td></td>
<td>• BlackBerry Configuration Database collation configured to default case-insensitive</td>
</tr>
<tr>
<td></td>
<td>• collation must be the same for the Microsoft SQL Server instance and the database server that hosts the BlackBerry database notification system (BlackBerry Configuration Database)</td>
</tr>
<tr>
<td></td>
<td>• default collations are suggested though non-default collations are supported (for more information, visit <a href="http://www.blackberry.com/go/kbhelp">www.blackberry.com/go/kbhelp</a> to read articles KB04785 and KB15534)</td>
</tr>
<tr>
<td>database connectivity</td>
<td>• TCP/IP network protocols turned on</td>
</tr>
<tr>
<td></td>
<td>• No count option turned off</td>
</tr>
<tr>
<td>nested triggers</td>
<td>Nested trigger support turned on. For more information, visit <a href="http://msdn.microsoft.com">msdn.microsoft.com</a> to read article ms178101.</td>
</tr>
<tr>
<td>database mirroring</td>
<td>To support database mirroring for the BlackBerry Configuration Database, the following conditions:</td>
</tr>
<tr>
<td></td>
<td>• Any of the following database management systems:</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2005 SP3 Enterprise Edition or Standard Edition (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2005 SP4 Enterprise Edition or Standard Edition (32-bit or 64-bit)</td>
</tr>
<tr>
<td>Item</td>
<td>Requirement</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2008 SP1 Enterprise Edition or Standard Edition (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2008 SP2 Enterprise Edition or Standard Edition (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2008 R2 Enterprise Edition or Standard Edition (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• the mirror database must reside on a different computer from the principal database</td>
</tr>
<tr>
<td></td>
<td>• the Microsoft SQL Server instances for both the principal and mirrored databases must be the same version and edition</td>
</tr>
<tr>
<td></td>
<td>• only use static port number 1433</td>
</tr>
<tr>
<td></td>
<td>• do not use named instances</td>
</tr>
<tr>
<td></td>
<td>• verify that the SQL Server Browser service is running</td>
</tr>
<tr>
<td></td>
<td>• turn off the Named Pipes option in the Microsoft SQL Server Native Client on the computers that host the BlackBerry Enterprise Server instances</td>
</tr>
</tbody>
</table>

**database transactional replication**  
To support database transactional replication for the BlackBerry Configuration Database, the following conditions:

- the database server must be Microsoft SQL Server 2005 SP3 or later
- the database server that hosts the replicated database must use the same version and build as the database server that hosts the primary database

**System requirements: BlackBerry Attachment Service**

The following system requirements apply to the computer that you install the BlackBerry Attachment Service on.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>operating system</td>
<td>Any of the following operating systems:</td>
</tr>
</tbody>
</table>
### System requirements: BlackBerry Collaboration Service

The following system requirements apply to the computer that you install the BlackBerry Collaboration Service on.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>operating system</td>
<td>Unless otherwise stated, any of the following operating systems:</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 R2 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2 SP1</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2012</td>
</tr>
</tbody>
</table>

###媒体播放器

One of the following:

- if using Windows Server 2008, to support audio attachments, Windows Media Format SDK (for more information, visit [msdn.microsoft.com](msdn.microsoft.com) and search Windows Media Format SDK)
- if using Windows Server 2003, to support audio attachments, Windows Media Player 9 or later

###浏览器

Windows Internet Explorer 7.0 to 8.0 with language preferences configured to display encoded web pages
### System requirements

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Sametime</td>
<td>IP address of the computer that hosts the BlackBerry Collaboration Service added to the CommunityConnectivity document on the IBM Sametime server</td>
</tr>
<tr>
<td>Novell GroupWise Messenger</td>
<td>SSL authentication turned on for the Novell GroupWise Messenger agents on the Novell GroupWise Messenger server</td>
</tr>
<tr>
<td>Microsoft Office Live Communications Server 2005 or Microsoft Office Communications Server 2007</td>
<td>The latest Microsoft hotfixes installed</td>
</tr>
</tbody>
</table>
| Microsoft Office Communications Server 2007 R2 | Any of the following operating systems:  
  - Windows Server 2003 R2 SP2 (64-bit)  
  - Windows Server 2008 SP2 (64-bit)  
  - Windows Server 2008 R2  
  - Windows Server 2008 R2 SP1  
  - Windows Server 2012  
  - The latest Microsoft hotfixes installed  
  - The BlackBerry Collaboration Service installed in the same Microsoft Active Directory domain as Microsoft Office Communications Server 2007 R2  
  - The Windows account that runs the BlackBerry Collaboration Service added to one of the following groups:  
    - RTCUniversalServerAdmins group, to automatically provision the BlackBerry Collaboration Service as a trusted service in Microsoft Active Directory (for more information, visit [msdn.microsoft.com](http://msdn.microsoft.com) to read about required Microsoft Active Directory permissions)  
    - RTCCComponentUniversalServices group, if you use another account with the required permissions (RTCUniversalServerAdmins) to manually provision the BlackBerry Collaboration Service as a trusted service in Microsoft Active Directory (for more information, see "Manually provision the BlackBerry Collaboration Service as a trusted application")  
  - Microsoft .NET Framework 3.5 SP1  
  - Microsoft Visual C++ 2008 Redistributable Package (vcredist_x64.exe)  
  - Microsoft SQL Server Native Client (sqlncli_x64.msi) |
<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
</table>
|       | • Microsoft Unified Communications Managed API 2.0 Core Redist 64-bit (ucmaredist.msi)  
|       | • Microsoft Office Communications Server 2007 R2, Core Components (ocscore.msi)  
|       | • The required certificate installed in the Personal Certificate folder for the local computer account  

For detailed instructions about the Microsoft install packages and installing the required certificate, see "Preparing the computer that hosts the BlackBerry Collaboration Service for use with Microsoft Office Communications Server 2007 R2".

| Microsoft Lync Server 2010 | • Any of the following operating systems:  
|                           | • Windows Server 2003 R2 SP2 (64-bit)  
|                           | • Windows Server 2008 SP2 (64-bit)  
|                           | • Windows Server 2008 R2  
|                           | • Windows Server 2008 R2 SP1  
|                           | • Windows Server 2012  
|                           | • The latest Microsoft hotfixes installed  
|                           | • The BlackBerry Collaboration Service installed in the same Microsoft Active Directory domain as Microsoft Lync Server 2010  
|                           | • The Windows account that runs the BlackBerry Collaboration Service added to one of the following groups:  
|                           | • RTCUniversalServerAdmins group, to automatically provision the BlackBerry Collaboration Service as a trusted service in Microsoft Active Directory (for more information, visit msdn.microsoft.com to read about required Microsoft Active Directory permissions)  
|                           | • RTCCComponentUniversalServices group, if you use another account with the required permissions (RTCUniversalServerAdmins) to manually provision the BlackBerry Collaboration Service as a trusted service in Microsoft Active Directory (for more information, see "Manually provision the BlackBerry Collaboration Service as a trusted application")  
|                           | • Microsoft .NET Framework 3.5 SP1  
|                           | • Microsoft Visual C++ 2008 Redistributable Package (vcredist_x64.exe)  


For detailed instructions about the Microsoft install packages and installing the required certificate, see "Preparing the computer that hosts the BlackBerry Collaboration Service for use with Microsoft Lync Server 2010".

### System requirements: BlackBerry MDS Connection Service

The following system requirements apply to the computer that you install the BlackBerry MDS Connection Service on.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>operating system</td>
<td>Any of the following operating systems:</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 R2 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2 SP1</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2012</td>
</tr>
<tr>
<td>memory</td>
<td>One of the following:</td>
</tr>
<tr>
<td>Item</td>
<td>Requirement</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• if you install a central push server and less than 1000 user accounts, a</td>
</tr>
<tr>
<td></td>
<td>minimum of 1024 MB</td>
</tr>
<tr>
<td></td>
<td>• if you install a central push server and more than 1000 user accounts, a</td>
</tr>
<tr>
<td></td>
<td>minimum of 3 GB</td>
</tr>
<tr>
<td></td>
<td>• if you do not install a central push server, a minimum of 512 MB</td>
</tr>
</tbody>
</table>

System requirements: BlackBerry Router

To install the BlackBerry Router on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server, any of the following operating systems:

- Windows Server 2003 SP2 (32-bit or 64-bit)
- Windows Server 2003 R2 SP2 (32-bit or 64-bit)
- Windows Server 2008 SP2 (32-bit or 64-bit)
- Windows Server 2008 R2
- Windows Server 2008 R2 SP1
- Windows Server 2012

System requirements for your organization's environment

The following system requirements apply when you configure single sign-on authentication for the BlackBerry Administration Service and BlackBerry Web Desktop Manager or configure the BlackBerry MDS Connection Service to support Integrated Windows authentication.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>network services</td>
<td>Microsoft Active Directory running at Windows Server 2003 domain functional level or higher</td>
</tr>
</tbody>
</table>
### System requirements: Computers for BlackBerry Web Desktop Manager and BlackBerry Administration Service users

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| browser                     | - Windows Internet Explorer 7.0 to 8.0  
- Mozilla Firefox 3.6+  
- Google Chrome 4.0+  
- Safari 4 for Mac  

Windows Internet Explorer 7 or later provides optimal support for BlackBerry Web Desktop Manager features and BlackBerry Administration Service features. Depending on the browser that you use, the BlackBerry Web Desktop Manager and BlackBerry Administration Service might not recognize BlackBerry devices and the browser might prevent you from activating devices that are connected to the computer, backing up and restoring device data, or adding or updating device applications. |
| browser settings for Windows Internet Explorer | To support browser access, you must configure the following settings:  
- language preferences configured to display encoded web pages  
- Microsoft hotfix 955839 installed on the users' computers to make sure the correct time zones are displayed  
- the following settings turned on to support Microsoft ActiveX: |
<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Automatic prompting for Microsoft ActiveX controls</td>
</tr>
<tr>
<td></td>
<td>• Download signed Microsoft ActiveX controls</td>
</tr>
<tr>
<td></td>
<td>• Run Microsoft ActiveX controls and plug-ins</td>
</tr>
<tr>
<td></td>
<td>• Script Microsoft ActiveX controls marked safe for scripting</td>
</tr>
<tr>
<td></td>
<td>• support for JavaScript</td>
</tr>
<tr>
<td></td>
<td>• cookies turned on</td>
</tr>
<tr>
<td></td>
<td>• support for TLS or SSL</td>
</tr>
<tr>
<td></td>
<td>• the SSL certificate installed to permit trusted connections to the BlackBerry Administration Service</td>
</tr>
<tr>
<td></td>
<td>• if using Windows Vista, the BlackBerry Administration Service web address added as a trusted web site and Enable protected mode cleared</td>
</tr>
<tr>
<td></td>
<td>• if you configure single sign-on authentication for the BlackBerry Administration Service</td>
</tr>
<tr>
<td></td>
<td>• the BlackBerry Web Desktop Manager and BlackBerry Administration Service web sites assigned to the local intranet zone</td>
</tr>
<tr>
<td></td>
<td>• Enable Integrated Windows Authentication selected</td>
</tr>
<tr>
<td></td>
<td>• if you do not configure single sign-on authentication for the BlackBerry Administration Service</td>
</tr>
<tr>
<td></td>
<td>• the BlackBerry Web Desktop Manager and BlackBerry Administration Service web sites assigned to the local intranet or trusted sites security zone</td>
</tr>
</tbody>
</table>

**browser settings for Firefox, Safari, and Google Chrome**

To support browser access, you must configure the following settings:

• support for JavaScript
• cookies turned on
• support for TLS or SSL
• to permit trusted connections to the BlackBerry Administration Service, the SSL certificate installed

Single sign-on authentication for the BlackBerry Administration Service is not supported by Google Chrome.
System requirements: Messaging server

Any of the following messaging servers that are located in close proximity to where you want to install the primary BlackBerry Enterprise Server:

- Microsoft Exchange 2010 SP1 Multi-Tenant Deployment is supported with the following conditions:
  - Microsoft Exchange Server 2010 SP1 Update Rollup 3
  - To manage calendars, enable Microsoft Exchange Web Services
  - Configure the BlackBerry Enterprise Server to run without public folders
- Microsoft Exchange Server 2010 SP1
- Microsoft Exchange Server 2010 and Microsoft Exchange Server 2010 Update Rollup 1 (Microsoft Exchange Server MAPI Client and CDO 1.2.1 must be version 6.5.8211.0 or later to support Microsoft Exchange Server 2010)
- Microsoft Exchange Server 2007 SP2 or SP3
- Microsoft Exchange Server 2003 SP2
- Any of the following Microsoft Exchange mixed environments:
  - Microsoft Exchange Server 2003 and 2007
  - Microsoft Exchange Server 2007 SP2 and 2010
  - Microsoft Exchange Server 2007 SP2 and 2010 SP1
  - Microsoft Exchange Server 2007 SP3 and 2010
  - Microsoft Exchange Server 2007 SP3 and 2010 SP1

System requirements: Firewall

To install the BlackBerry Enterprise Server, configure a firewall or proxy firewall with the following conditions:

- Exclusive use of port 3101 to open and maintain an outbound, bidirectional TCP/IP connection to an external server
- Support for resolving Internet addresses that use DNS
- For proxy firewalls, transparency of the proxy server
System requirements: Instant messaging server

To install the BlackBerry Enterprise Server, any of the following instant messaging servers:

- IBM Sametime 7.0 Community Server
- IBM Sametime 7.5 Community Server
- IBM Sametime 8.0 Community Server
- IBM Sametime 8.0.1 Community Server
- IBM Sametime 8.0.2 Community Server
- IBM Sametime 8.5 Community Server
- Microsoft Office Live Communications Server 2005 SP1 Standard or Enterprise
- Microsoft Office Communications Server 2007 Standard or Enterprise
- Microsoft Office Communications Server 2007 R2
- Microsoft Lync Server 2010
- Novell GroupWise Messenger 2.0 or later

Supported features and environments

<table>
<thead>
<tr>
<th>Item</th>
<th>BlackBerry Enterprise Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual environment</td>
<td>For information, please visit <a href="http://www.blackberry.com">www.blackberry.com</a> to read KB 29661.</td>
</tr>
<tr>
<td>authentication</td>
<td></td>
</tr>
<tr>
<td>IP</td>
<td>BlackBerry Enterprise Server components support only IPv4 for TCP/IP connections.</td>
</tr>
<tr>
<td>SNMP monitoring</td>
<td>The BlackBerry Enterprise Server components support the SNMP service.</td>
</tr>
<tr>
<td>Remote access</td>
<td>The BlackBerry Enterprise Server components support remote access by administrators who use Remote Desktop Connection.</td>
</tr>
</tbody>
</table>
# Unsupported environments

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMZ</td>
<td>The BlackBerry Enterprise Server and BlackBerry Enterprise Server components, with the exception of the BlackBerry Router, do not support installation in a DMZ.</td>
</tr>
<tr>
<td>messaging server</td>
<td>The BlackBerry Enterprise Server for Microsoft Exchange (and all BlackBerry Enterprise Server components) does not support installation on the computer that hosts the messaging server.</td>
</tr>
<tr>
<td>email application</td>
<td>The BlackBerry Enterprise Server and BlackBerry Enterprise Server components do not support installation on computers that host email applications such as Microsoft Outlook. Email applications use data files that can cause conflicts with the BlackBerry Enterprise Server components. As a result, the BlackBerry Enterprise Server components might not function as expected.</td>
</tr>
<tr>
<td>instant messaging server</td>
<td>Any of the following environments:</td>
</tr>
<tr>
<td></td>
<td>• If you configure the BlackBerry Enterprise Server for high availability, the primary BlackBerry Enterprise Server instance and standby BlackBerry Enterprise Server instance do not support more than one type of instant messaging server in a BlackBerry Enterprise Server pair. For example, if you install the BlackBerry Collaboration Service for use with Microsoft Office Communications Server 2007 on the primary instance, you must also install the BlackBerry Collaboration Service for use with Microsoft Office Communications Server 2007 on the standby instance.</td>
</tr>
<tr>
<td></td>
<td>• A BlackBerry Enterprise Server or BlackBerry Enterprise Server pair that connects to multiple instances of the BlackBerry Collaboration Service does not support more than one type of instant messaging server. You must use the same type of instant messaging server for each local or remote BlackBerry Collaboration Service that you connect to a BlackBerry Enterprise Server or BlackBerry Enterprise Server pair.</td>
</tr>
<tr>
<td>BlackBerry Collaboration Service</td>
<td>If you install the BlackBerry Collaboration Service for use with Microsoft Lync Server 2010, the BlackBerry Collaboration Service does not support using ocscore.msi or ucmaredist.msi from the Microsoft Lync Server 2010 installation files on the computer that you install the BlackBerry Collaboration Service on. You must use ocscore.msi and ucmaredist.msi from Microsoft Office</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Communications Server 2007 R2</td>
<td>For more information, visit the Volume Licensing Service Center at <a href="http://www.microsoft.com">www.microsoft.com</a>.</td>
</tr>
<tr>
<td>BlackBerry Attachment Service</td>
<td>You must install the software update for KB22953 on Windows Server 2008 if you want the BlackBerry Attachment Service to support .mp3 audio files on BlackBerry devices and all audio formats on BlackBerry 7100 Series devices that support CDMA networks. To download the software update for KB22953, visit <a href="http://www.blackberry.com/support/downloads/">www.blackberry.com/support/downloads/</a>.</td>
</tr>
<tr>
<td>Remote Desktop Services or Terminal Services</td>
<td>The BlackBerry Enterprise Server and BlackBerry Enterprise Server components do not support installation on a computer that you installed Remote Desktop Services or Terminal Services on.</td>
</tr>
</tbody>
</table>
Preupgrade tasks

Configuring a Microsoft Exchange 2010 messaging environment

Create a Windows account that has a Microsoft Exchange 2010 mailbox

You must create a Windows account with a Microsoft Exchange 2010 mailbox so that the Windows account can authenticate with the Microsoft Exchange Server.

**Before you begin:** If you want free/busy lookups to work in Microsoft Outlook 2003 and earlier, you must configure Microsoft Exchange 2010 to support Microsoft Outlook 2003 and earlier by creating a public folder database. For more information about supporting Microsoft Outlook 2003 and earlier, visit [http://support.microsoft.com](http://support.microsoft.com) to read article 555851 and visit [http://technet.microsoft.com](http://technet.microsoft.com) to read articles 123694, 124270, 397221, and 691120.

1. On the computer that hosts Microsoft Exchange, log in using an administrator account that has the permission to create accounts.
2. Open the Microsoft Exchange Management Console.
3. Create an account and mailbox that you name **BESAdmin**.
4. To permit the BlackBerry Enterprise Server to check if a BlackBerry device user has permission to access a public folder, assign the Owner permission for all public folders to the administrator account.

**After you finish:**
- To verify that you created the Windows account, log in to a computer using the Windows account.
- Verify that the Windows account is not a member of the Domain Administrators group in Microsoft Active Directory.
- Verify that BlackBerry device users have Read permissions and Visible permissions to public folders.
- To permit BlackBerry device users to check the availability of meeting participants using BlackBerry Device Software 4.5 or later, configure the Schedule+ Free/Busy information for the system public folder. For more information, visit [http://technet.microsoft.com](http://technet.microsoft.com) to read articles 629523 and 691129.
Configure Microsoft Exchange 2010 permissions for the Windows account

Before you begin:
Verify the domain name in Microsoft Active Directory. When you set the permissions, you must match the domain name in Microsoft Active Directory.

1. On a computer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management Shell.
3. Type `Add-RoleGroupMember "View-Only Organization Management" -Member "BESAdmin"`.
4. Do one of the following:
   - To set the permissions at the organizational unit level, type the following command:
     ```powershell
     Add-ADPermission -InheritedObjectType User -InheritanceType Descendents -ExtendedRights Send-As -User "BESAdmin" -Identity "OU=<organizational_unit>,DC=<domain_1>,DC=<domain_2>,DC=<domain_3>"
     ```
     For example, if the organizational unit is Texas and the domain name is example.organization.net, type `Texas` for `<organizational_unit>`, `example` for `<domain_1>`, `organization` for `<domain_2>`, and `net` for `<domain_3>`.
   - To set the permissions at the common name level, type the following command:
     ```powershell
     Add-ADPermission -InheritedObjectType User -InheritanceType Descendents -ExtendedRights Send-As -User "BESAdmin" -Identity "CN=<common_name>,DC=<domain_1>,DC=<domain_2>,DC=<domain_3>"
     ```
     For example, if the common name is Users and the domain name is example.organization.net, type `Users` for `<common_name>`, `example` for `<domain_1>`, `organization` for `<domain_2>`, and `net` for `<domain_3>`.

In each command, `<domain_1>`, `<domain_2>`, and `<domain_3>` form the internal Microsoft Active Directory domain (if internal and external domain names are different). You can contact your Microsoft Active Directory administrator for information about distinguished names.

After you finish: If you create a mailbox database for Microsoft Exchange, repeat step 2.

Increase the maximum number of connections to the Address Book service in Microsoft Exchange 2010

By default, Microsoft Exchange 2010 limits the maximum number of connections from the BlackBerry Enterprise Server to the Address Book service to 50. To permit the BlackBerry Enterprise Server to run, you must increase the number of permitted connections to a large value (for example, 100,000).
Before you begin: You must complete this task if the messaging server that the BlackBerry Enterprise Server uses is Microsoft Exchange 2010. If the messaging server is Microsoft Exchange 2010 SP1, you can change the MaxSessionsPerUser settings using client throttling policies.

1. On the computer that hosts the Microsoft Exchange CAS server, in `<drive>:\Program Files\Microsoft\Exchange Server \V14\Bin`, in a text editor, open the `microsoft.exchange.addressbook.service.exe.config` file.
2. Change the value of the `MaxSessionsPerUser` key to `100000`.
3. Save and close the file.
4. Restart the Address Book service.

Turn off client throttling in Microsoft Exchange 2010

By default, Microsoft Exchange 2010 uses client throttling policies to track the bandwidth that each Microsoft Exchange user consumes and enforce bandwidth limits as necessary. The policies affect the performance of the BlackBerry Enterprise Server, so you should turn off client throttling for the Windows account that has a Microsoft Exchange mailbox.

1. On a computer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management Shell.
2. Type `New-ThrottlingPolicy BESPolicy`.
3. Type the following command:
   ```powershell
   Set-ThrottlingPolicy BESPolicy -RCAMaxConcurrency $null -RCAPercentTimeInAD $null -RCAPercentTimeInCAS $null -RCAPercentTimeInMailboxRPC $null -EWSMaxConcurrency $null -EWSPercentTimeInAD $null -EWSPercentTimeInCAS $null -EWSPercentTimeInMailboxRPC $null -EWSMaxSubscriptions $null -EWSFastSearchTimeoutInSeconds $null -EWSFindCountLimit $null
   ```
4. Type `Set-Mailbox "BESAdmin" -ThrottlingPolicy BESPolicy`.

Configure a management role and scope for Microsoft Exchange Web Services

If you want the BlackBerry Enterprise Server to use Microsoft Exchange Web Services to manage calendars on BlackBerry devices, you must configure a management role and scope for Microsoft Exchange Web Services in Microsoft Exchange 2010.

For more information about configuring the BlackBerry Enterprise Server to use Microsoft Exchange Web Services, see the `BlackBerry Enterprise Server Administration Guide`.

1. On a computer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management Shell.
2. Do one or more of the following:
To enable a service account for all users in an organization, type the following command:

```
New-ManagementRoleAssignment -Name: <role_name> -Role ApplicationImpersonation -User: <account_name>
```

To create a management scope for a specific group, type the following command:

```
New-ManagementScope -Name: <scope_name> –RecipientRestrictionFilter: <member_names> -RecipientRoot: <domain_name>
```

To enable a service account for all users in a scope, type the following command:

```
New-ManagementRoleAssignment –Name: <role_name> –Role ApplicationImpersonation –User: <account_name> –CustomRecipientWriteScope: <scope_name>
```

Configure the BlackBerry Enterprise Server to run without public folders

If you did not install any public folders in Microsoft Exchange, you must configure the BlackBerry Enterprise Server to run without public folders by changing a registry key.

1. On each computer that hosts the BlackBerry Enterprise Server, click Start > Run.
2. In the Open field, type regedit.
3. Click OK.
4. Perform one of the following actions:
   - If you are running a 32-bit version of Windows, navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft \Windows Messaging Subsystem\CDO.
   - If you are running a 64-bit version of Windows, navigate to HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node \Microsoft\Windows Messaging Subsystem.
5. If the CDO registry key does not exist, create a registry key that you name CDO.
6. In the CDO registry key, if the DWORD value does not exist, create a DWORD value that you name Ignore No PF.
7. Change the DWORD value to 1.
8. Click OK.
Permit meeting requests from outside of your organization when using Microsoft Exchange Web Services for Microsoft Exchange 2010

By default, the BlackBerry Enterprise Server uses Microsoft Exchange Web Services to manage calendars on BlackBerry devices. Each time you add a new Microsoft Exchange mailbox, you must configure the calendar settings in Microsoft Exchange to permit BlackBerry device users to receive meeting requests from outside of your organization when using Microsoft Exchange Web Services.

1. On a computer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management Shell.

2. For each Microsoft Exchange Server that hosts users, type the following command:

   \texttt{Get-Mailbox -server<messaging-server name>| Set-CalendarProcessing -ProcessExternalMeetingMessages $true}

Configuring a Microsoft Exchange 2007 messaging environment

Create a Windows account that has a Microsoft Exchange 2007 mailbox

You must create a Windows account that has a Microsoft Exchange 2007 mailbox so that the Windows account can authenticate with the Microsoft Exchange Server.

\textbf{Before you begin:} You must configure Microsoft Exchange 2007 to support versions of Microsoft Outlook that are earlier than 2007 by creating a public folder database. For more information about supporting versions of Microsoft Outlook that are earlier than 2007, visit \url{http://support.microsoft.com} to read article 555851 and visit \url{http://technet.microsoft.com} to read articles 123694, 124270, 397221, and 691120.

1. On the computer that hosts Microsoft Exchange, log in using an administrator account that has the correct permission to create accounts.

2. Open the Microsoft Exchange Management Console.

3. Create an account and mailbox that you name \texttt{BESAdmin}. 
4. To permit the BlackBerry Enterprise Server to check if a user has permissions for a public folder, assign the Owner permission for all public folders to the administrator account.

**After you finish:**
- To verify that you created the Windows account, log in to a computer using the Windows account.
- Verify that the Windows account is not a member of the Domain Administrators group in Microsoft Active Directory.
- Verify that BlackBerry device users have Read and Visible permissions to public folders.
- To permit BlackBerry device users to check the availability of meeting participants in BlackBerry Device Software 4.5 or later, configure the Schedule+ Free/Busy information for the system public folder. For more information, visit [http://technet.microsoft.com](http://technet.microsoft.com) to read articles 629523 and 691129.

### Configure Microsoft Exchange 2007 permissions for the Windows account

1. On a computer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management Shell.
2. Perform one of the following actions:
   - If you log in to Microsoft Exchange Server 2007, type `add-exchangeadministrator "BESAdmin" -role ViewOnlyAdmin`.
   - If you log in to another computer, type `get-mailboxserver "<messaging_server_name>" | add-exchangeadministrator "BESAdmin" -role ViewOnlyAdmin`.
3. For each Microsoft Exchange Server 2007 instance that hosts BlackBerry device users, type the following command: `get-mailboxserver "<messaging_server_name>" | add-adpermission -user "BESAdmin" -accessrights ExtendedRight -extendedrights Receive-As, ms-Exch-Store-Admin`.

### Permit users to send email messages in a Microsoft Exchange environment

To permit BlackBerry device users to send email messages, you must configure Send As permissions for the Microsoft Active Directory user object that contains users. This task describes how to configure the Send As permissions for the entire Windows domain, but you can also configure the permissions at the user object level or on a container of user objects.

For more information about Send As permissions and the BlackBerry Enterprise Server, visit [www.blackberry.com/btsc](http://www.blackberry.com/btsc) to read article KB04707. For more information about assigning Send As permissions permissions to multiple user accounts, visit [support.microsoft.com](http://support.microsoft.com) to read article 912918.
1. Log in to a computer in the Windows domain as an administrator that has permissions to change user objects in Microsoft Active Directory.


3. On the View menu, click Advanced Features.

4. Right-click the domain root. Click Properties.


6. Click Add.

7. Type the name of the Windows account that you created (for example, BESAdmin).

8. Click Check Names.

9. Click OK.

10. Perform one of the following actions:
    • If you are running Windows Server 2003, in the Apply drop-down list, click User Objects.
    • If you are running Windows Server 2008, in the Apply drop-down list, click Descendant User Objects.

11. In the Allow column, select the Send As check box.

12. Click Apply.

13. Click OK.

---

**Permit meeting requests from outside of your organization when using Microsoft Exchange Web Services for Microsoft Exchange 2007**

By default, the BlackBerry Enterprise Server uses Microsoft Exchange Web Services to manage calendars on BlackBerry devices. Each time you add a new Microsoft Exchange mailbox, you must configure the calendar settings in Microsoft Exchange to permit BlackBerry device users to receive meeting requests from outside of your organization when using Microsoft Exchange Web Services.

1. On a computer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management Shell.

2. For each Microsoft Exchange Server that hosts users, type the following command:
   ```powershell
   Get-Mailbox -server<messaging-server name> | Set-MailboxCalendarSettings -ProcessExternalMeetingMessages $true
   ```
Configuring a Microsoft Exchange 2003 messaging environment

Create a Windows account that has a Microsoft Exchange 2003 mailbox

You must create a Windows account that has a Microsoft Exchange 2003 mailbox so that the Windows account can authenticate with the Microsoft Exchange messaging server.

1. On any computer in the Windows domain, on the taskbar, click Start > Programs > Microsoft Exchange > Active Directory Users and Computers.
2. Create an account that has the following attributes:
   • Name: BESAdmin
   • Group membership: Domain User
3. Create a Microsoft Exchange mailbox for the account.
4. To activate the new mailbox, send a test email message.

After you finish:

If you cannot see the Windows account in the Microsoft Active Directory to verify that you created it, log in to a computer using the Windows account.

For more information about the Send As permission and the BlackBerry Enterprise Server, visit www.blackberry.com to read KB04707.

For more information about assigning the Send As permission to multiple user accounts, visit www.support.microsoft.com to read article 912918.

Configure Microsoft Exchange 2003 permissions for the Windows account

On each Microsoft Exchange 2003 server that hosts BlackBerry device users, you must configure Microsoft Exchange permissions for the Windows account (for example, BESAdmin) that you want to use to install the BlackBerry Enterprise Server components.
This task describes how to configure the Microsoft Exchange permissions at the administrative group level for every Microsoft Exchange 2003 server that hosts BlackBerry device users but you can also configure the permissions at other levels, such as at the root of the organization or another administrative group.

1. On the computer that hosts the Microsoft Exchange 2003 System Manager, open the Microsoft Exchange 2003 System Manager.

2. Configure the Exchange View Only Administrator permission for the Windows account in the administrative group that contains the Microsoft Exchange 2003 servers that host BlackBerry device users.

3. On each Microsoft Exchange 2003 server that hosts BlackBerry device users, assign the following permissions to the Windows account:
   - Send As
   - Receive As
   - Administer Information Store

4. To permit the BlackBerry Enterprise Server to check if users have permissions to access a public folder, assign the Owner permission for all public folders to the Windows account.

**After you finish:** Verify that the users have Read and Visible permissions to public folders.

### Permit users to send email messages in a Microsoft Exchange environment

To permit BlackBerry device users to send email messages, you must configure Send As permissions for the Microsoft Active Directory user object that contains users. This task describes how to configure the Send As permissions for the entire Windows domain, but you can also configure the permissions at the user object level or on a container of user objects.

For more information about Send As permissions and the BlackBerry Enterprise Server, visit [www.blackberry.com/btsc](http://www.blackberry.com/btsc) to read article KB04707. For more information about assigning Send As permissions permissions to multiple user accounts, visit [support.microsoft.com](http://support.microsoft.com) to read article 912918.

1. Log in to a computer in the Windows domain as an administrator that has permissions to change user objects in Microsoft Active Directory.

2. On the taskbar, click **Start** > **Administrative Tools** > **Active Directory Users and Computers**.

3. On the **View** menu, click **Advanced Features**.

4. Right-click the domain root. Click **Properties**.

5. On the **Security** tab, click **Advanced**.

6. Click **Add**.

7. Type the name of the Windows account that you created (for example, BESAdmin).

8. Click **Check Names**.
9. Click **OK**.

10. Perform one of the following actions:
    - If you are running Windows Server 2003, in the **Apply** drop-down list, click **User Objects**.
    - If you are running Windows Server 2008, in the **Apply** drop-down list, click **Descendant User Objects**.

11. In the **Allow** column, select the **Send As** check box.

12. Click **Apply**.

13. Click **OK**.

Configure permissions for the Windows account

On each computer that you want to install the BlackBerry Enterprise Server components on, you must configure permissions for the Windows account that you want to use to install the BlackBerry Enterprise Server components and run the services for the BlackBerry Enterprise Server.

Without the correct permissions, the BlackBerry Enterprise Server cannot run.

1. Right-click **My Computer**. Click **Manage**.

2. In the left pane, expand **Local Users and Groups**.

3. Navigate to the **Groups** folder.

4. In the right pane, double-click **Administrators**.

5. Click **Add**.

6. In the **Enter the object names to select** field, type the Windows account name that you want the services for the BlackBerry Enterprise Server to use (for example, BESAdmin).

7. Click **OK**.

8. Click **Apply**.

9. Click **OK**.

10. On the taskbar, click **Start > Programs > Administrative Tools > Local Security Policy**.

11. Configure the following permissions for the Windows account:
    - log on locally with local permissions (if not assigned by default)
    - log on as a service

12. On the taskbar, click **Start > Programs > Administrative Tools > Computer Management**.
13. Add the Windows account to the local administrators group.

Prevent the Microsoft Exchange known issues for wireless calendar synchronization

Some known issues for Microsoft Exchange impact how the BlackBerry Enterprise Server synchronizes calendars over the wireless network. To prevent the known issues from occurring, you can read about the known issues for Microsoft Exchange that might impact your organization’s messaging environment and install the hotfixes for them. If your organization’s messaging environment includes multiple messaging servers, you can resolve the known issues that apply to the latest Microsoft Exchange software version in your organization’s environment.

If you do not install the correct hotfixes, the BlackBerry Enterprise Server cannot run.

2. Verify that your organization’s environment meets the requirements that are described in the applicable known issues.
3. Download the hotfixes for the known issues on the computers that you want to install the BlackBerry Enterprise Server or BlackBerry Administration Service on.
4. Install the hotfixes.

Verify if the Windows account can access a user account in Microsoft Exchange

The BlackBerry Enterprise Server requires permission to access each BlackBerry device user’s mailbox to process email messages. The IEMSText.exe tool runs a test to verify whether the Windows account has the Send As permission in Microsoft Exchange so that the BlackBerry Enterprise Server can access user accounts. The IEMSText.exe tool does not verify whether the BlackBerry Enterprise Server can send email messages on behalf of a BlackBerry device user.

1. Copy the BlackBerry Enterprise Server installation files to the computer that you want to install the BlackBerry Enterprise Server on.
2. Extract the contents to a folder on the computer.
3. Navigate to <extracted_folder>\Tools.
4. Double-click IEMSTest.exe.
5. In the **Profile Name** drop-down list, select the profile names for the user accounts.

6. Click **OK**.

7. In the left pane, select the user accounts that you want to check.

8. Click **Select**.

9. Click **OK**.

### Configuring connections for the BlackBerry Enterprise Server database

The database for the BlackBerry Enterprise Server is the **BlackBerry Configuration Database**. You create the BlackBerry Configuration Database when you install a BlackBerry Enterprise Server or BlackBerry Administration Service or when you run the CreateDB executable.

The BlackBerry Enterprise Server can connect to its database on the Microsoft SQL Server using Windows authentication or database authentication. By default, the BlackBerry Enterprise Server logs in to its database using the Windows account that you use to complete the installation process or the database credentials you provided during the installation process.

To support database mirroring for the BlackBerry Configuration Database with Microsoft SQL Server 2005 or Microsoft SQL Server 2008, you must use Windows authentication.

### Specifying permissions when you connect to the BlackBerry Configuration Database using Windows authentication or Microsoft SQL Server authentication

If you connect the BlackBerry Enterprise Server to the BlackBerry Configuration Database using Windows authentication or Microsoft SQL Server authentication during the BlackBerry Enterprise Server installation process, the Windows account or Microsoft SQL Server account that you specify must have database permissions on the database server. The type of permissions that you specify is determined by the setup option that you select and whether you create the BlackBerry Configuration Database on the computer that hosts the BlackBerry Enterprise Server components or on another database server.
Specifying permissions for the Windows account or Microsoft SQL Server account

If you install Microsoft SQL Server 2008 R2 Express Edition during the BlackBerry Enterprise Server installation process, you might need to specify permissions for the Windows account or Microsoft SQL Server account, depending on the type of authentication you select.

When you select Windows authentication during the BlackBerry Enterprise Server installation process, the setup application automatically assigns the required permissions to the Windows account that you use to complete the installation process.

When you select Microsoft SQL Server authentication during the BlackBerry Enterprise Server installation process, you must assign the required database permissions to the Microsoft SQL Server account that you use to complete the installation process.

Assign permissions to the Windows account or Microsoft SQL Server account

Perform one of the following actions:

- If you create the BlackBerry Configuration Database on the computer that hosts the BlackBerry Enterprise Server and you require the setup application to install Microsoft SQL Server Express during the installation process and you choose Windows authentication, you are not required to assign Microsoft SQL Server permissions to the Windows account. If you want the setup application to install the BlackBerry database notification system, you must assign the Microsoft SQL Server permission for the database system administrator (also called the sysadmin server role in Microsoft SQL Server Management Studio) to the Windows account.

- If you create the BlackBerry Configuration Database on the computer that hosts the BlackBerry Enterprise Server and you require the setup application to install Microsoft SQL Server Express during the installation process and you choose Microsoft SQL Server authentication, you must assign the database creator (dbcreator server role) Microsoft SQL Server permission to the Microsoft SQL Server account. If you want the setup application to install the BlackBerry database notification system, you must assign the Microsoft SQL Server permission for the database system administrator (also called the sysadmin server role in Microsoft SQL Server Management Studio) to the Microsoft SQL Server account.

- If you create the BlackBerry Configuration Database on the computer that hosts the BlackBerry Enterprise Server and the computer already hosts a Microsoft SQL Server, you must assign the database creator (dbcreator server role) Microsoft SQL Server permission to the Windows account or Microsoft SQL Server account that you use to complete the BlackBerry Enterprise Server installation process. If you want the setup application to install the BlackBerry database notification system, you must assign the Microsoft SQL Server permission for the database system administrator (also called the sysadmin server role in Microsoft SQL Server Management Studio) to the Windows account or Microsoft SQL Server account.

- If you create the BlackBerry Configuration Database on a computer that does not host the BlackBerry Enterprise Server, you must assign the database creator (dbcreator server role) Microsoft SQL Server permission to the Windows account or Microsoft SQL Server account.
or Microsoft SQL Server account that you use to complete the BlackBerry Enterprise Server installation process. If you want the setup application to install the BlackBerry database notification system, you must assign the Microsoft SQL Server permission for the database system administrator (also called the sysadmin server role in Microsoft SQL Server Management Studio) to the Windows account or Microsoft SQL Server account.

Resolving IT policy and application control policy conflicts in a mixed version environment

In BlackBerry Enterprise Server versions earlier than version 5.0, the BlackBerry Policy Service queues delivery requests for IT policies and application control policies and sends them to BlackBerry devices. In BlackBerry Enterprise Server version 5.0, the BlackBerry Administration Service queues the IT policies and application control policies, and the BlackBerry Policy Service sends them to BlackBerry devices.

To avoid conflicts between the BlackBerry Policy Service and BlackBerry Administration Service in a mixed version environment, the setup application tries to turn off application polling by the BlackBerry Policy Service for each BlackBerry Enterprise Server instance in the BlackBerry Enterprise Server domain before it starts the upgrade process. When the setup application turns off application polling, it prevents earlier versions of the BlackBerry Policy Service from queuing delivery requests for IT policies and application control policies.

If the setup application cannot turn off application polling for all BlackBerry Enterprise Server instances (for example, a computer that hosts one of the BlackBerry Enterprise Server instances is not running), you must run the BB50UpgradePrep tool manually before you can upgrade the BlackBerry Enterprise Server.

Resolve IT policy and application control policy conflicts in a mixed version environment

1. Copy the BlackBerry Enterprise Server installation media to the computer that hosts a BlackBerry Enterprise Server.
2. Extract the contents to a folder on the computer.
3. In the <extracted_folder>/tools folder, double-click BB50UpgradePrep.exe.
4. Complete the instructions on the screen.
Backing up the BlackBerry Enterprise Server databases

You must back up the BlackBerry Enterprise Server databases so that you can restore them if the BlackBerry Enterprise Server upgrade process does not complete.

If your organization's environment includes Microsoft SQL Server, use the backup and restore tools that Microsoft provides to back up the BlackBerry Enterprise Server databases.

If your organization's environment includes Microsoft SQL Server Express, you can use the BlackBerry Configuration Database Backup Tool that is included with the BlackBerry Enterprise Server installation media to back up the BlackBerry Enterprise Server databases to a file. By default, the backup file is named `<database_name><YYYYMMDDHHMMSS>.bak`.

Back up the BlackBerry Enterprise Server databases

1. Copy the BlackBerry Enterprise Server installation files to the computer that hosts the BlackBerry Enterprise Server database that you want to back up.
2. Extract the installation files to a folder on the computer.
3. At the command prompt, navigate to the `Tools` folder in the BlackBerry Enterprise Server installation files.
4. Run `BlackBerryDbBackup.exe`.

Example

To back up a BlackBerry Configuration Database that is named BESMgmt to a folder that is named `DB_backup_folder`, when you use the database credentials `sqlusername` and `sqlpassword`, type

`BlackBerryDBBackup.exe -d BESMgmt -f C:\DB_backup_folder -U sqlusername -P sqlpassword`

BlackBerry Configuration Database Backup Tool parameters

The parameters listed in brackets are optional.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-d &lt;database_name&gt;</td>
<td>This parameter specifies the name of the BlackBerry Enterprise Server database (for example, BESMgmt).</td>
</tr>
<tr>
<td>[-f] &lt;folder&gt;</td>
<td>This parameter specifies the folder that you want to save the backup file in.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>If you specify a folder, it must already exist. The default folder is the current folder location.</td>
<td></td>
</tr>
<tr>
<td>[-S] <code>&lt;database_server&gt;</code></td>
<td>This parameter specifies the name of the computer that hosts the BlackBerry Enterprise Server database.</td>
</tr>
<tr>
<td>[-E]</td>
<td>This parameter specifies that you want to use Windows authentication instead of database authentication to connect to the database server. Your login account must have the database owner permission. The default value is false (Windows authentication).</td>
</tr>
<tr>
<td>[-U] <code>&lt;user_name&gt;</code></td>
<td>This parameter specifies the user name that you use for database authentication. To use a login account that is different from the default login account, the account must have database owner permission. The default user name is sa.</td>
</tr>
<tr>
<td>[-P] <code>&lt;password&gt;</code></td>
<td>This parameter specifies the password that you use for database authentication.</td>
</tr>
<tr>
<td>[-p] <code>&lt;percentage&gt;</code></td>
<td>This parameter specifies the interval, as a percentage, that you want the BlackBerry Configuration Database Backup Tool to report progress at. The default percentage is 10.</td>
</tr>
<tr>
<td>[-?]</td>
<td>This parameter specifies information about the BlackBerry Configuration Database Backup Tool. You do not require any other parameters when you use this parameter.</td>
</tr>
</tbody>
</table>

Removing the BlackBerry MDS Integration Service

The BlackBerry MDS Integration Service is no longer in production. If you installed the BlackBerry MDS Integration Service, you must remove it before you can upgrade to BlackBerry Enterprise Server 5.0 SP4 or later.

You can choose one of the following options to remove the BlackBerry MDS Integration Service:

- You can perform the following actions:
  1. Run setup.exe from the BlackBerry Enterprise Server 5.0 SP1 or 5.0 SP2 installation files and clear the check box for the BlackBerry MDS Integration Service
2. After you finish, you must remove the BlackBerry MDS Integration Service component information from the BlackBerry Configuration Database using the BlackBerry Administration Service.

- You can run the CreateDB executable that is included with the BlackBerry Enterprise Server 5.0 SP4 installation files. For more information, visit www.blackberry.com/btsc to read article KB25012.

Run the CreateDB executable to remove the BlackBerry MDS Integration Service

You must remove the BlackBerry MDS Integration Service before you can upgrade to BlackBerry Enterprise Server 5.0 SP4 or later. You can run the CreateDB executable that is included with the BlackBerry Enterprise Server installation files to remove the BlackBerry MDS Integration Service.

Before you begin:

Verify that you configured the correct permissions on the database server that hosts the BlackBerry Configuration Database.

1. Perform one of the following actions:
   - Log in to the computer that hosts the database server as a local administrator or using a Windows account that has SQL administrator permissions.
   - Log in to the computer that hosts the BlackBerry Enterprise Server.

2. Copy the BlackBerry Enterprise Server installation files to the computer.

3. Extract the contents to a folder on the computer.

4. Navigate to <extracted_folder>\Database.

5. Open the BesMgmt.cfg file in a text editor.

6. Change the file to include information that is specific to your organization’s environment.

7. Change CMD=Install to CMD=Upgrade.

8. Change BACKUP=false to BACKUP=true.

9. If you logged in to the computer that hosts the BlackBerry Enterprise Server, you must specify the USERID and PASSWORD for the account that has SQL administrator permissions.

10. Save and close the file.

11. Open a command prompt window.

12. Navigate to <extracted_folder>\Database.

13. Type CreateDB.exe BESMgmt.cfg.
## BESMgmt.cfg properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMD</td>
<td>This property specifies the type of action that the CreateDB executable must complete (for example, whether to install or upgrade the BlackBerry Configuration Database).</td>
</tr>
<tr>
<td>DATABASE_NAME</td>
<td>This property specifies the name of the BlackBerry Configuration Database.</td>
</tr>
<tr>
<td>SERVER</td>
<td>This property specifies the name of the database server that hosts the BlackBerry Configuration Database. If a database instance hosts the BlackBerry Configuration Database, follow the format <code>database_server_name\database_instance_name</code>.</td>
</tr>
<tr>
<td>USERID</td>
<td>If you use database authentication, this property specifies the user name of the database account that has server administrator permission and database creator permission.</td>
</tr>
<tr>
<td>PASSWORD</td>
<td>If you use database authentication, this property specifies the password for the database account.</td>
</tr>
<tr>
<td>SCRIPT_ROOT</td>
<td>This property specifies the path to the DBInstallScripts folder. By default, this folder is in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
<tr>
<td>LOG_DIR</td>
<td>This property specifies the path to the folder that you want to create log files in. By default, this folder is in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
<tr>
<td>DBMS</td>
<td>This property specifies the database management system that your organization uses.</td>
</tr>
<tr>
<td>DB_FILE_DIR</td>
<td>This property specifies an existing folder that you want to save the database files in. By default, this folder is in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
<tr>
<td>BACKUP_DIR</td>
<td>This property specifies an existing folder where you want to save the database backup in. By default, this folder is located in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
<tr>
<td>BES_TYPE</td>
<td>This property specifies the messaging server that your organization uses.</td>
</tr>
</tbody>
</table>

## Upgrade implications for VoIP profiles

For BlackBerry Enterprise Server versions that are earlier than version 5.0 SP3, you can use the BlackBerry Administration Service to configure VoIP profiles and IT policy rules from the VoIP policy group only for BlackBerry 7270 smartphones. In BlackBerry Enterprise Server 5.0 SP3 and later, VoIP profiles and VoIP IT policy rules are no longer available in the
BlackBerry Administration Service console and you cannot use the BlackBerry Administration Service to configure the IT policy rules. To configure VoIP for BlackBerry device users, you must use the BlackBerry Mobile Voice System.

If your organization’s environment includes VoIP profiles or VoIP IT policy rules that you configured, the upgrade process removes the VoIP profiles when you upgrade to BlackBerry Enterprise Server 5.0 SP3 and later. When the upgrade process removes VoIP profiles, the BlackBerry Administration Service must reconcile IT policies for all devices that you associated VoIP profiles or VoIP IT policy rules with, which can cause a significant amount of reconciliation depending on the number of devices that use VoIP profiles or VoIP IT policy rules that you configured.

If you are upgrading from BlackBerry Enterprise Server 5.0 SP2 and you do not want reconciliation to occur during the upgrade process, you can perform the following actions before you upgrade to the latest BlackBerry Enterprise Server version:

- remove all VoIP profiles from user accounts
- review all IT policies, and if VoIP IT policy rules are configured, select the value to be blank to reset the IT policies to default values

### Delete a VoIP profile

**Before you begin:** Verify that the VoIP profile is not assigned to a user account or associated with a Wi-Fi profile.

1. In the BlackBerry Administration Service, on the **BlackBerry solution management** menu, expand **Policy > Wi-Fi configuration**.
2. Click **Manage VoIP profiles**.
3. Click the name of a VoIP profile.
4. Click **Delete profile**.
5. Click **Yes - Delete the profile**.

### Install the SNMP service for monitoring by a monitoring application

You must install the SNMP service on each computer that you want to install the BlackBerry Enterprise Server if you want to use a monitoring application to monitor the BlackBerry Enterprise Server activity.

**Before you begin:** Verify that each computer can access the Windows installation media.

1. On the taskbar, click **Start > Settings > Control Panel > Add/Remove Programs > Add/Remove Windows Components**.
2. Double-click **Management and Monitoring Tools**.
3. Select the **Simple Network Management Protocol** check box.

4. Click **OK**.

5. When Windows Setup prompts you, install the files from the Windows installation media.

6. Complete the installation wizard.

7. In the Windows Services, verify that the SNMP service is running.

**After you finish:** To complete the SNMP service installation process, after you install the BlackBerry Enterprise Server or BlackBerry Enterprise Server components, configure the SNMP service to monitor the activity of the BlackBerry Enterprise Server or BlackBerry Enterprise Server components.

---

### Creating a BlackBerry Administration Service pool that includes the BlackBerry Web Desktop Manager using DNS round robin

When you install the BlackBerry Administration Service, BlackBerry Web Desktop Manager, or both, the setup application installs the BlackBerry Administration Service services automatically. The BlackBerry Administration Service and BlackBerry Web Desktop Manager require the BlackBerry Administration Service services to run.

If you create a BlackBerry Administration Service pool using DNS round robin, you can install the BlackBerry Administration Service and BlackBerry Web Desktop Manager on each computer in the pool or you can install the BlackBerry Administration Service or BlackBerry Web Desktop Manager on some of the computers in the pool. If you install the BlackBerry Administration Service and BlackBerry Web Desktop Manager on each computer in the pool, you can use the pool name that you specified during the installation process in the URLs for the BlackBerry Administration Service and BlackBerry Web Desktop Manager (for example, https://<pool_name>/webconsole/login or https://<pool_name>/webdesktop/login).

If you do not install both components on each computer in the pool and you try to access one of the URLs using the pool name, the web browser might display an HTTP 404 error message. The HTTP 404 error message occurs when the web browser tries to connect to a computer in the pool that you did not install the component on that you are trying to access. For example, you can install the BlackBerry Administration Service on two of the computers in the pool and the BlackBerry Web Desktop Manager on two other computers in the pool.

To make sure that the web browser does not display HTTP 404 error messages, you can choose one of the following options:

- You can create separate pools within the BlackBerry Administration Service pool for the BlackBerry Administration Service and the BlackBerry Web Desktop Manager. You can provide your organization's administrators and BlackBerry device users with URLs that include the specific pool names.
You can provide administrators and users in your organization’s environment with URLs that include the FQDNs of the computers that you installed the BlackBerry Administration Service or BlackBerry Web Desktop Manager on (for example, https://<FQDN_of_computer>/webconsole/login or https://<FQDN_of_computer>/webdesktop/login).

Create the DNS record for a BlackBerry Administration Service instance

To configure multiple BlackBerry Administration Service instances for high availability using DNS round robin, you must create a DNS record. The DNS record permits the clients of the BlackBerry Administration Service pool to access the instances using a single DNS name. You must create the DNS record in the same domain as the computers that host the BlackBerry Administration Service instances.

Before you begin:
- Configure a static IP address for each computer that you want to install a BlackBerry Administration Service instance on.
- Obtain permission to manage the DNS.
- If you configure DNS round robin, configure clients to resolve the DNS name into a list of IP addresses and distribute traffic equally across the BlackBerry Administration Service instances in the pool.

1. Log in to the DNS server.
2. In the DNS management console, access the forward lookup zone that you want to add the BlackBerry Administration Service instance to.
3. To create a new host, perform the following actions:
   1. In the Name field, type the name of the BlackBerry Administration Service pool that you want to use.
   2. In the IP Address1 field, type the IP address of the computer that you want to host a BlackBerry Administration Service instance on.
   3. Select the Create associated pointer (PTR) record check box.
4. Repeat step 3 for each BlackBerry Administration Service instance that you want to install. When you add entries to the same pool, you must use the same pool name for all BlackBerry Administration Service instances.

After you finish: To remove a BlackBerry Administration Service instance from a pool, delete the entry for the IP address of the BlackBerry Administration Service instance from the DNS server.
Preparing the computer that hosts the BlackBerry Collaboration Service for use with Microsoft Office Communications Server 2007 R2

If you plan to install the BlackBerry Collaboration Service for use with Microsoft Office Communications Server 2007 R2, you must verify that the computer that you install the BlackBerry Collaboration Service on includes the required items.

Before you install the BlackBerry Collaboration Service, you must perform the following actions in the order that they are listed below:

1. Install and enable Microsoft .NET Framework 3.5 SP1 (if you installed Microsoft .NET Framework 4.0, visit support.microsoft.com to read article 2224981 before you continue).

2. For the following steps, use the install packages included with the Microsoft Office Communications Server 2007 R2 installation files. For steps a and b, you can find the files in Setup\amd64, and for steps c and d, you can find the files in Setup\amd64\Setup.
   a  Install Microsoft Visual C++ 2008 Redistributable Package (vcredist_x64.exe).
   b  Install Microsoft SQL Server Native Client (sqlncli_x64.msi).
   c  Install Microsoft Unified Communications Managed API 2.0 Core Redist 64-bit (ucmaredist.msi).
   d  Install Microsoft Office Communications Server 2007 R2, Core Components (ocscore.msi).

3. Install the required certificate in the Personal Certificate folder for the local computer account. You must choose the Web Server Certificate template and specify the following information:
   • For the Subject Name, type the FQDN of the computer that you install the BlackBerry Collaboration Service on.
   • For the Friendly Name, type OCSCConnector.

To download the install packages, visit the Microsoft Download Center or the Volume Licensing Service Center at www.microsoft.com.

For more information about installing the required certificate, visit www.blackberry.com/btsc to read article KB24960.
Preparing the computer that hosts the BlackBerry Collaboration Service for use with Microsoft Lync Server 2010

If you plan to install the BlackBerry Collaboration Service for use with Microsoft Lync Server 2010, you must verify that the computer that you install the BlackBerry Collaboration Service on includes the required items.

Before you install the BlackBerry Collaboration Service, you must perform the following actions in the order that they are listed below:

1. Install and enable Microsoft .NET Framework 3.5 SP1 (if you installed Microsoft .NET Framework 4.0, visit support.microsoft.com to read article 2224981 before you continue).
2. For the following steps, use the install packages included with Microsoft Lync Server 2010 installation files. You can find the files in Setup\amd64.
   a. Install Microsoft Visual C++ 2008 Redistributable Package (vcredist_x64.exe).
   b. Install Microsoft SQL Server Native Client (sqlncli_x64.msi).
3. For the following steps, you need to download the software from the Volume Licensing Service Center at www.microsoft.com.
   a. Install Microsoft Unified Communications Managed API 2.0 Core Redist 64-bit (ucmaredist.msi).
   b. Install Microsoft Office Communications Server 2007 R2, Core Components (ocscore.msi).
4. Install the required certificate in the Personal Certificate folder for the local computer account. You must choose the Web Server Certificate template and specify the following information:
   - For the Subject Name, type the FQDN of the Microsoft Lync Server 2010 pool.
   - For the Subject Alternative Names, type the FQDN of the Microsoft Lync Server 2010 pool and the FQDN of the computer that you install the BlackBerry Collaboration Service on.
   - For the Friendly Name, type OCSCconnector.

The BlackBerry Collaboration Service supports Microsoft Unified Communications Managed API 2.0 and must use Microsoft Office Communications Server 2007 R2, Core Components to take advantage of the backwards compatibility of Microsoft Lync Server 2010 with Microsoft Unified Communications Managed API 2.0. The BlackBerry Collaboration Service does not support using ocscore.msi or ucmaredist.msi from the Microsoft Lync Server 2010 installation files.

To download the install packages, visit the Microsoft Download Center or the Volume Licensing Service Center at www.microsoft.com.

For more information about installing the required certificate, visit www.blackberry.com/btsc to read article KB24960.
Applications that are installed with the BlackBerry Enterprise Server components

You can use the BlackBerry Enterprise Server installation process to install third-party applications.

<table>
<thead>
<tr>
<th>Application</th>
<th>BlackBerry Enterprise Server components that the application is installed with</th>
</tr>
</thead>
<tbody>
<tr>
<td>JDK 1.6.x</td>
<td>• BlackBerry Enterprise Server (core)</td>
</tr>
<tr>
<td></td>
<td>• BlackBerry Administration Service</td>
</tr>
<tr>
<td>JRE 1.6.x</td>
<td>• BlackBerry Enterprise Server (core)</td>
</tr>
<tr>
<td></td>
<td>• BlackBerry Administration Service</td>
</tr>
<tr>
<td></td>
<td>• BlackBerry Collaboration Service</td>
</tr>
<tr>
<td></td>
<td>• BlackBerry MDS Connection Service</td>
</tr>
<tr>
<td>Microsoft XML Core Services 6.0 SP2</td>
<td>• All components except the BlackBerry Router</td>
</tr>
<tr>
<td>Microsoft SQL Server 2008 R2 Express Edition</td>
<td>• BlackBerry Administration Service</td>
</tr>
<tr>
<td>(if selected)</td>
<td>• Any other components</td>
</tr>
<tr>
<td>Microsoft .NET Framework 2.0</td>
<td>• All components</td>
</tr>
<tr>
<td>(if you are installing Microsoft SQL Server</td>
<td></td>
</tr>
<tr>
<td>Express)</td>
<td></td>
</tr>
<tr>
<td>Microsoft .NET Framework 3.5 SP1</td>
<td>• BlackBerry Collaboration Service</td>
</tr>
<tr>
<td>(if you are installing Microsoft Office</td>
<td></td>
</tr>
<tr>
<td>Communications Server 2007 R2 or Microsoft</td>
<td></td>
</tr>
<tr>
<td>Lync Server 2010)</td>
<td></td>
</tr>
</tbody>
</table>
Prerequisites: Upgrading the BlackBerry Enterprise Server software

- The BlackBerry Configuration Database and all BlackBerry Administration Service instances in the BlackBerry Enterprise Server domain must run the same version of the BlackBerry Enterprise Server software. Before you upgrade the BlackBerry Configuration Database, you must stop the BlackBerry Administration Service services that run on all other computers in the BlackBerry Enterprise Server domain until you upgrade the computers.

- Install or upgrade the BlackBerry Administration Service on the computer that you perform the upgrade process on in the BlackBerry Enterprise Server domain first.

- In a Windows Server 2003 environment, to install Microsoft SQL Server 2008 R2 Express Edition during the installation of BlackBerry Enterprise Server, you must install Windows PowerShell 1.0, Microsoft .NET Framework 3.5 SP1, and Microsoft Windows Installer 4.5 before you run the BlackBerry Enterprise Server setup application.

- Upgrade all BlackBerry Enterprise Server instances to version 5.0 SP2 or later.

- If you installed the BlackBerry MDS Integration Service, you must remove it before you upgrade to the latest BlackBerry Enterprise Server version.

- Retrieve the following information:
  - BlackBerry Client Access License key
  - SRP host (for BlackBerry Enterprise Server 5.0 and later, the format of the SRP host is different from earlier versions)
  - SRP identifier
  - SRP key
  - computer name and port number of the instant messaging server (use the virtual server name and port number where the AJAX service is installed for Microsoft Office Live Communications Server 2005 and Microsoft Office Communications Server 2007)
  - computer name and port number of the proxy server (optional)

- If you upgrade from the BlackBerry Enterprise Server Small Business Edition to a BlackBerry Enterprise Server, you must obtain a BlackBerry Enterprise Server Trade-Up Key. For more information, visit www.blackberry.com/btsc to read article KB03535.

- Delete inactive user accounts from the BlackBerry Enterprise Server.

- If you upgrade from BlackBerry Enterprise Server software 5.0 or earlier, remove the BlackBerry Administration API from all of the computers that host the BlackBerry Administration Service in the BlackBerry Enterprise Server domain. You can use the Windows control panel to remove the BlackBerry Administration API. In BlackBerry Enterprise Server
5.0 SP1 and later, the setup application installs the BlackBerry Administration API automatically when the setup application installs the BlackBerry Administration Service.

- Close all BlackBerry Manager instances in the BlackBerry Enterprise Server domain and do not open the instances again. If you run the BlackBerry Manager with BlackBerry Enterprise Server 5.0 and later, you might experience issues with the BlackBerry Configuration Database.

- Back up the BlackBerry Enterprise Server databases.

- If you configured database replication for the BlackBerry Configuration Database, turn database replication off during the upgrade process to avoid possible errors.

- If you installed the BlackBerry database notification system on a remote Microsoft SQL Server, upgrade the BlackBerry database notification system manually.

- If you configured the BlackBerry Administration Service instances in a pool to communicate across network subnets using TCP, you must configure the instances again in the BlackBerry Administration Service after you complete the upgrade process.

- Verify that the Windows account that you use to upgrade the BlackBerry Enterprise Server software is the same account that you used to install the BlackBerry Enterprise Server software.

- If you install the BlackBerry Administration Service, verify that a WAN bridge does not separate the computers that host the BlackBerry Administration Service and BlackBerry Configuration Database.

- If you perform the upgrade on a computer that has more than one NIC, verify that the production NIC is first in the bind order in Windows network settings.

- If you want to install Microsoft SQL Server 2008 R2 Express Edition on a computer that does not host any BlackBerry Enterprise Server components, you can navigate to the Tools folder in the BlackBerry Enterprise Server installation files and run Sqlexpr.exe.

### Performing a test upgrade of the BlackBerry Configuration Database

If you want to make sure that you can upgrade the BlackBerry Configuration Database in your organization’s environment without any issues or if you want to find out how long it takes to upgrade the BlackBerry Configuration Database, you can perform a test upgrade of the BlackBerry Configuration Database.

When you perform a test upgrade of the BlackBerry Configuration Database, you back up the BlackBerry Configuration Database, restore the backup version of the BlackBerry Configuration Database to a database server that does not host the BlackBerry Configuration Database, and then run the CreateDB executable.
Perform a test upgrade of the BlackBerry Configuration Database

Before you begin: Verify that you configured the appropriate permissions on the database server that you want to perform a test upgrade of the BlackBerry Configuration Database on.

1. Log in to the computer that hosts the BlackBerry Configuration Database using a local administrator account or a Windows account that has SQL administrator permissions.
2. Back up the BlackBerry Configuration Database.
3. Log in to a computer that hosts a database server that you want to perform a test upgrade of the BlackBerry Configuration Database on using a local administrator account or a Windows account that has SQL administrator permissions.
4. Restore the backup version of the BlackBerry Configuration Database.
5. Copy the BlackBerry Enterprise Server installation files to the database server.
6. Extract the contents to a folder on the computer.
7. Navigate to <extracted_folder>\Database.
8. Open the BesMgmt.cfg file in a text editor.
9. Change the file to include information that is specific to your organization’s environment.
10. Save and close the file.
11. Open a command prompt window.
12. Change to <extracted_folder>\Database.
13. Type CreateDB.exe BESMgmt.cfg.

BESMgmt.cfg properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMD</td>
<td>This property specifies the type of action that the CreateDB executable must complete (for example, whether to install or upgrade the BlackBerry Configuration Database).</td>
</tr>
<tr>
<td>DATABASE_NAME</td>
<td>This property specifies the name of the BlackBerry Configuration Database.</td>
</tr>
<tr>
<td>SERVER</td>
<td>This property specifies the name of the database server that hosts the BlackBerry Configuration Database. If a database instance hosts the BlackBerry Configuration Database, follow the format database_server_name\database_instance_name.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>USERID</td>
<td>If you use database authentication, this property specifies the user name of the database account that has server administrator permission and database creator permission.</td>
</tr>
<tr>
<td>PASSWORD</td>
<td>If you use database authentication, this property specifies the password for the database account.</td>
</tr>
<tr>
<td>SCRIPT_ROOT</td>
<td>This property specifies the path to the DBInstallScripts folder. By default, this folder is in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
<tr>
<td>LOG_DIR</td>
<td>This property specifies the path to the folder that you want to create log files in. By default, this folder is in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
<tr>
<td>DBMS</td>
<td>This property specifies the database management system that your organization uses.</td>
</tr>
<tr>
<td>DB_FILE_DIR</td>
<td>This property specifies an existing folder that you want to save the database files in. By default, this folder is in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
<tr>
<td>BACKUP_DIR</td>
<td>This property specifies an existing folder where you want to save the database backup in. By default, this folder is located in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
<tr>
<td>BES_TYPE</td>
<td>This property specifies the messaging server that your organization uses.</td>
</tr>
</tbody>
</table>
Upgrading the BlackBerry Enterprise Server software by using the in-place upgrade process

Using the in-place upgrade process, you can upgrade the BlackBerry Enterprise Server software by replacing the existing version and upgrading the BlackBerry Configuration Database.

You can use the in-place upgrade process if your organization’s environment includes a standalone BlackBerry Enterprise Server instance.

When you use the in-place upgrade process, all BlackBerry devices receive new IT policies. BlackBerry devices that are running BlackBerry Device Software version 4.1 or later receive new service books and data synchronization occurs over the wireless network.

Advantages of this upgrade process include:

- You do not require an extra computer to perform this upgrade.
- When the upgrade process completes, user accounts are active and no additional administrative action is required.

Disadvantages of this upgrade process include:

- After you upgrade the BlackBerry Enterprise Server, you cannot return to an earlier version of the software automatically.
- You must turn off the BlackBerry Enterprise Server during the upgrade process. The interruption to services for BlackBerry devices lasts for as long as it takes the upgrade process to complete.
Upgrade the BlackBerry Enterprise Server software by overwriting the existing version and retaining the existing BlackBerry Configuration Database

The in-place upgrade process requires that you restart the computer. During the BlackBerry Enterprise Server installation process, you must restart the computer.

Before you begin:

- If your organization uses the tools available in the BlackBerry Enterprise Server Resource Kit to manage the BlackBerry Enterprise Server, download and install versions of the tools that match the version of the upgraded BlackBerry Enterprise Server. For more information about the BlackBerry Enterprise Server Resource Kit, visit www.blackberry.com/go/serverdocs to read the documentation for the BlackBerry Enterprise Server Resource Kit.
- If a remote Microsoft SQL Server hosts the BlackBerry Configuration Database, upgrade the BlackBerry database notification system.
- Document the existing software configurations before you start the upgrade process so that you can create the software configurations again after the upgrade process is complete. For more information, see the BlackBerry Enterprise Server Administration Guide.
- If you configured database mirroring for the BlackBerry Configuration Database, you must verify that the principal database is available before you upgrade the BlackBerry Enterprise Server.

1. Log in to the computer using the Windows account that the BlackBerry Enterprise Server services run on.
2. In the BlackBerry Enterprise Server installation files, double-click setup.exe.
3. In the Setup type dialog box, select Use an existing BlackBerry Configuration Database.
4. In the Database information dialog box, perform the following actions:
   a. Verify the names of the database server and BlackBerry Configuration Database that the BlackBerry Enterprise Server uses.
   b. If you configured the database server to use static ports, select the Static option. If the static port number is not 1433, in the Port field, type the port number.
5. In the Database mirroring options dialog box, if you want to configure database mirroring, select the Add support for database mirroring check box and type the name of the database server that hosts the mirror database in the Name of the mirror database server field. The setup application does not create the BlackBerry Configuration Database on
the mirror Microsoft SQL Server; it adds a registry key to the computer that includes the name of the mirror Microsoft SQL Server.

6. In the MAPI Settings dialog box, perform the following actions:
   a. In the Microsoft Exchange server field, type the name of the Microsoft Exchange server.
   b. In the Mailbox field, type the name of the administrator that has the appropriate permissions.
   c. Click Check Name.
   d. Click OK.

7. In the Setup options dialog box, for the first upgrade in the BlackBerry Enterprise Server domain and to install the BlackBerry Administration Service, under Additional Components, select BlackBerry Administration Service. If you do not want to install the BlackBerry Administration Service, you must perform the first upgrade in the BlackBerry Enterprise Server domain on a computer that the BlackBerry Administration Service is already installed on.

8. If the setup application prompts you to restart the computer, click Yes.

9. Log in to the computer using the same account that you used in step 1.

10. If you upgrade from the BlackBerry Collaboration Service for use with Windows Messenger, in the Instant messaging settings dialog box, type the Microsoft Office Communicator Web Access server address.

11. In the Administration settings dialog box, perform the following actions:
   a. In the Pool name field, type an FQDN that the setup application can use to create the BlackBerry Administration Service web address. If you install only one BlackBerry Administration Service instance in the BlackBerry Enterprise Server domain, you can accept the default pool name. If you install more than one BlackBerry Administration Service instance in the BlackBerry Enterprise Server domain, you must create a DNS entry for the pool name that is not the name of a computer and is mapped to the IP address of each BlackBerry Administration Service instance.
   
   b. In the New password and Confirm password fields, type the password for the SSL certificate that the BlackBerry Administration Service uses to authenticate with browsers. You must use the same password for every BlackBerry Administration Service instance in the BlackBerry Enterprise Server domain.

12. In the Microsoft Active Directory settings dialog box, in the User password field, type the password for the Microsoft Active Directory account that the BlackBerry Enterprise Server uses to authenticate with Microsoft Active Directory (for example, BESAdmin). If you want to specify a different username and Windows domain, you must make sure that the Windows domain belongs to the same Microsoft Active Directory forest as the Microsoft Exchange organization.

13. In the Advanced administration settings dialog box, perform one of the following actions:
   • If you select Use Windows authentication, you can choose to use the Microsoft Active Directory account that you used in the previous step, or you can specify login information for a Microsoft Active Directory administrator.
   • If you select Use BlackBerry Administration Service authentication, type and confirm a password for the BlackBerry Administration Service administrator account. Consider using the minimum rules for password complexity when you create the password for the administrator account. The password should be at least 8 characters in length and contain at least one number, letter, and special character, and should not contain dictionary words.

You use the login information that you specify to log in to the BlackBerry Administration Service for the first time.
14. Start the services for the BlackBerry Enterprise Server. If you installed the BlackBerry Administration Service, the setup application waits until the BlackBerry Administration Service services are running before the setup application continues.

15. In the Console addresses dialog box, copy the web addresses for the BlackBerry Enterprise Server components and paste them into a document for future reference. You can use the web addresses to log in to the BlackBerry Enterprise Server components that you installed.

Specifying a name for the BlackBerry Administration Service pool during the installation process

During the installation process, the setup application prompts you to specify the name of the BlackBerry Administration Service pool.

The BlackBerry Administration Service instances use the pool name for interprocess communication and when you configure BlackBerry Administration Service high availability using DNS round robin. You must specify a valid DNS host name during the installation process, even if you do not configure BlackBerry Administration Service high availability using DNS round robin.

The setup application uses the FQDN of the computer that you install the first BlackBerry Administration Service instance on as the default value for the pool name. If you keep the default value and configure BlackBerry Administration Service high availability using DNS round robin at a later time, you must use the BlackBerry Configuration Panel to change the pool name to the host name for the pool.

The name for the BlackBerry Administration Service pool does not impact BlackBerry Administration Service high availability that uses a hardware load balancer.

For more information about BlackBerry Administration Service high availability, see the BlackBerry Enterprise Server Planning Guide.

Upgrade the BlackBerry Enterprise Server instances that you configured for disaster recovery

If you configured the BlackBerry Enterprise Server instances in your organization's environment for disaster recovery, you configured two BlackBerry Enterprise Server instances that use the same SRP address. You can upgrade the BlackBerry Enterprise Server instances to the latest BlackBerry Enterprise Server version and configure high availability so that the BlackBerry Enterprise Server instances can fail over automatically.
1. Upgrade the standby BlackBerry Enterprise Server using the in-place upgrade process. During the upgrade process, do not verify the SRP credentials or start the BlackBerry Enterprise Server services so that you do not deactivate the SRP credentials.

2. Stop BlackBerry Enterprise Server so that you can start a manual failover process.

3. Start the latest BlackBerry Enterprise Server version so that it becomes the primary instance.

4. Verify that users can send and receive messages on their BlackBerry devices.

5. Upgrade the earlier BlackBerry Enterprise Server version using the in-place upgrade process. During the upgrade process, specify that this BlackBerry Enterprise Server instance is a standby BlackBerry Enterprise Server, and associate it with the BlackBerry Enterprise Server instance that you upgraded in step 1.

6. Using the BlackBerry Administration Service, fail over to the BlackBerry Enterprise Server manually that you want to use as the primary instance.

7. Configure the automatic failover feature.

**After you finish:** For more information, see the *BlackBerry Enterprise Server Installation Guide* and the *BlackBerry Enterprise Server Administration Guide*. 
Upgrading the BlackBerry Enterprise Server using the cutover upgrade process and upgrading the existing BlackBerry Configuration Database

You can use the cutover upgrade process to install a BlackBerry Enterprise Server on a new computer and move user accounts and server information from a previous BlackBerry Enterprise Server to the new one.

If you upgrade the existing BlackBerry Configuration Database, you can move user accounts from the previous BlackBerry Enterprise Server to the new one using the BlackBerry Administration Service.

The BlackBerry Configuration Database and all BlackBerry Administration Service instances in the BlackBerry Enterprise Server domain must be the same version. Before you upgrade the BlackBerry Configuration Database, you must stop the BlackBerry Administration Service services that run on all other computers in the BlackBerry Domain until you upgrade the computers.

Advantages of the cutover upgrade process include:

- You can move user accounts back to the previous BlackBerry Enterprise Server if you experience issues with the new one.
- You can upgrade server hardware.
- Users experience minimal service interruptions because user accounts remain active on the previous BlackBerry Enterprise Server until you start the new one.

Disadvantages of this upgrade process include:

- You require an extra computer.
- The BlackBerry Enterprise Server sends new service books to all devices that can synchronize data over the wireless network.
Upgrade a BlackBerry Configuration Database

If you are not a database administrator and you do not have permissions to modify the BlackBerry Configuration Database, you can request that a database administrator with the appropriate permissions upgrades the BlackBerry Configuration Database before you run the setup application and upgrade the BlackBerry Enterprise Server.

Before you begin: Verify that you configured the proper permissions on the database server.

1. Log in to the computer that hosts the database server as a local administrator or using a Windows account that has SQL administrator permissions.
2. Copy the BlackBerry Enterprise Server installation files to the database server that hosts the BlackBerry Configuration Database.
3. Extract the contents to a folder on the computer.
4. Navigate to <extracted_folder>\Database.
5. Open the BesMgmt.cfg file in a text editor.
6. Change the file to include information that is specific to your organization’s environment.
7. Save and close the file.
8. Open a command prompt window.
9. Navigate to <extracted_folder>\Database.
10. Type CreateDB.exe BESMgmt.cfg.

BESMgmt.cfg properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMD</td>
<td>This property specifies the type of action that the CreateDB executable must complete (for example, whether to install or upgrade the BlackBerry Configuration Database).</td>
</tr>
<tr>
<td>DATABASE_NAME</td>
<td>This property specifies the name of the BlackBerry Configuration Database.</td>
</tr>
<tr>
<td>SERVER</td>
<td>This property specifies the name of the database server that hosts the BlackBerry Configuration Database. If a database instance hosts the BlackBerry Configuration Database, follow the format database_server_name\database_instance_name.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>USERID</td>
<td>If you use database authentication, this property specifies the user name of the database account that has server administrator permission and database creator permission.</td>
</tr>
<tr>
<td>PASSWORD</td>
<td>If you use database authentication, this property specifies the password for the database account.</td>
</tr>
<tr>
<td>SCRIPT_ROOT</td>
<td>This property specifies the path to the DBInstallScripts folder. By default, this folder is in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
<tr>
<td>LOG_DIR</td>
<td>This property specifies the path to the folder that you want to create log files in. By default, this folder is in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
<tr>
<td>DBMS</td>
<td>This property specifies the database management system that your organization uses.</td>
</tr>
<tr>
<td>DB_FILE_DIR</td>
<td>This property specifies an existing folder that you want to save the database files in. By default, this folder is in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
<tr>
<td>BACKUP_DIR</td>
<td>This property specifies an existing folder where you want to save the database backup in. By default, this folder is located in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
<tr>
<td>BES_TYPE</td>
<td>This property specifies the messaging server that your organization uses.</td>
</tr>
</tbody>
</table>

Install the BlackBerry Enterprise Server on a new computer and upgrade the existing BlackBerry Configuration Database

To manage the BlackBerry Enterprise Server, you must install the BlackBerry Administration Service. You can install the BlackBerry Administration Service on the computer that hosts the BlackBerry Enterprise Server or on a separate computer. You must either install or upgrade the BlackBerry Administration Service on the computer that you perform the installation process on in the BlackBerry Enterprise Server domain first.

During the BlackBerry Enterprise Server installation process, you must restart the computer.

**Before you begin:**
• Document the existing software configurations before you start the upgrade process so that you can create the software configurations again after the upgrade process is complete. For more information, see the *BlackBerry Enterprise Server Administration Guide*.

• If you configured database mirroring for the BlackBerry Configuration Database, you must verify that the principal database is available before you upgrade the BlackBerry Enterprise Server.

1. Log in to the computer using the Windows account that you want the BlackBerry Enterprise Server services to run on.
2. In the BlackBerry Enterprise Server installation files, double-click *setup.exe*.
3. In the **Setup type** dialog box, select **Use an existing BlackBerry Configuration Database**.
4. In the **Database information** dialog box, perform the following actions:
   a. Verify the names of the database server and BlackBerry Configuration Database that the BlackBerry Enterprise Server uses.
   b. If you configured the database server to use static ports, select the **Static** option. If the static port number is not 1433, in the **Port** field, type the port number.
5. In the **Database mirroring options** dialog box, if you want to configure database mirroring, select the **Add support for database mirroring** check box and type the name of the database server that hosts the mirror database in the **Name of the mirror database server** field. The setup application does not create the BlackBerry Configuration Database on the mirror Microsoft SQL Server; it adds a registry key to the computer that includes the name of the mirror Microsoft SQL Server.
6. In the **MAPI Settings** dialog box, perform the following actions:
   a. In the **Microsoft Exchange server** field, type the name of the Microsoft Exchange server.
   b. In the **Mailbox** field, type the name of the administrator that has the appropriate permissions.
   c. Click **Check Name**.
   d. Click **OK**.
7. In the **Setup options** dialog box, consider the following information:
   • For the first upgrade in a BlackBerry Enterprise Server domain and to install the BlackBerry Administration Service, select **BlackBerry Administration Service** under **Additional Components**.
   • To install the BlackBerry Administration Service by itself, select **Remote component** and **BlackBerry Administration Service**.
8. If the setup application prompts you to restart the computer, click **Yes**.
9. Log in to the computer using the same account that you used in step 1.
10. In the **CAL and SRP Information** dialog box, type the SRP credentials that the BlackBerry Enterprise Server that you are replacing uses.
11. In the **Administration settings** dialog box, perform the following actions:
   a. In the **Pool name** field, type an FQDN that the setup application can use to create the BlackBerry Administration Service web address. If you install only one BlackBerry Administration Service instance in the BlackBerry Enterprise Server domain, you can accept the default pool name. If you install more than one
BlackBerry Administration Service instance in the BlackBerry Enterprise Server domain, you must create a DNS entry for the pool name that is not the name of a computer and is mapped to the IP address of each BlackBerry Administration Service instance.

b. In the **New password** and **Confirm password** fields, type the password for the SSL certificate that the BlackBerry Administration Service uses to authenticate with browsers. You must use the same password for every BlackBerry Administration Service instance in the BlackBerry Enterprise Server domain.

12. In the **Microsoft Active Directory settings** dialog box, in the **User password** field, type the password for the Microsoft Active Directory account that the BlackBerry Enterprise Server uses to authenticate with Microsoft Active Directory (for example, BESAdmin). If you want to specify a different username and Windows domain, you must make sure that the Windows domain belongs to the same Microsoft Active Directory forest as the Microsoft Exchange organization.

13. In the **Advanced administration settings** dialog box, perform one of the following actions:
   • If you select **Use Windows authentication**, you can choose to use the Microsoft Active Directory account that you used in the previous step, or you can specify login information for a Microsoft Active Directory administrator.
   • If you select **Use BlackBerry Administration Service authentication**, type and confirm a password for the BlackBerry Administration Service administrator account. Consider using the minimum rules for password complexity when you create the password for the administrator account. The password should be at least 8 characters in length and contain at least one number, letter, and special character, and should not contain dictionary words.

   You use the login information that you specify to log in to the BlackBerry Administration Service for the first time.

14. If you specified the SRP credentials of an existing BlackBerry Enterprise Server in the BlackBerry Enterprise Server domain, do not start the BlackBerry Enterprise Server services.

15. In the **Console addresses** dialog box, copy the web addresses for the BlackBerry Enterprise Server components and paste them into a document for future reference. You can use the web addresses to log in to the BlackBerry Enterprise Server components that you installed.

### Specifying a name for the BlackBerry Administration Service pool during the installation process

During the installation process, the setup application prompts you to specify the name of the BlackBerry Administration Service pool.

The BlackBerry Administration Service instances use the pool name for interprocess communication and when you configure BlackBerry Administration Service high availability using DNS round robin. You must specify a valid DNS host name during the installation process, even if you do not configure BlackBerry Administration Service high availability using DNS round robin.

The setup application uses the FQDN of the computer that you install the first BlackBerry Administration Service instance on as the default value for the pool name. If you keep the default value and configure BlackBerry Administration Service high availability using DNS round robin at a later time, you must use the BlackBerry Configuration Panel to change the pool name to the host name for the pool.
The name for the BlackBerry Administration Service pool does not impact BlackBerry Administration Service high availability that uses a hardware load balancer. For more information about BlackBerry Administration Service high availability, see the *BlackBerry Enterprise Server Planning Guide*.

**Move user accounts to a new BlackBerry Enterprise Server using the BlackBerry Administration Service**

To complete the cutover upgrade process, you must move user accounts to the new BlackBerry Enterprise Server. After you move the user accounts to the current BlackBerry Enterprise Server, the BlackBerry Enterprise Server sends new service books to the BlackBerry devices automatically.

1. In the BlackBerry Administration Service, on the **BlackBerry Solution management** menu, expand **User**.
2. Click **Manage Users**.
3. Click **Advanced**.
4. In the **BlackBerry Enterprise Server criteria** section, click the BlackBerry Enterprise Server that you want to move user accounts from.
5. Click **Search**.
6. Click **Manage multiple users**.
7. Select the user accounts that you want to move to the new BlackBerry Enterprise Server at the same time.
8. Click **Switch BlackBerry user to different BlackBerry Enterprise Server**.
9. Select the new BlackBerry Enterprise Server from the list.
10. Click **Save All**.

**After you finish:** Reassign the IT policies to the user accounts.
Prevent the previous BlackBerry Enterprise Server from connecting to the BlackBerry Infrastructure

If you try to connect two BlackBerry Enterprise Server instances to the BlackBerry Infrastructure using identical SRP credentials, the BlackBerry Infrastructure deactivates the credentials, and wireless traffic stops.

1. In the Windows Services, stop all BlackBerry Enterprise Server services.
2. Change the startup type for all BlackBerry Enterprise Server services to **Disabled**.

Start the new BlackBerry Enterprise Server

In the Windows Services, start the BlackBerry Enterprise Server services in the following order:

- BlackBerry Controller
- BlackBerry Router
- BlackBerry Dispatcher
- all remaining services

**After you finish:** After you complete the upgrade process, users must reactivate their BlackBerry devices. Instruct users to connect their BlackBerry devices to the BlackBerry Desktop Software or BlackBerry Web Desktop Manager to receive new SRP routing and service name information.
Upgrading the BlackBerry Enterprise Server using the cutover upgrade process and creating a BlackBerry Configuration Database

Using the cutover upgrade process, you can install the BlackBerry Enterprise Server on a new computer and move user accounts and server information from the previous BlackBerry Enterprise Server to the new one.

You can use the cutover upgrade process to create a new BlackBerry Configuration Database and BlackBerry Enterprise Server domain. If you create a new BlackBerry Configuration Database, you require SRP credentials for the new BlackBerry Enterprise Server. You can move user accounts from the previous BlackBerry Configuration Database to the new BlackBerry Configuration Database using the BlackBerry Enterprise Transporter.

When you use the cutover upgrade process, all BlackBerry devices receive new IT policies. BlackBerry devices that are running BlackBerry Device Software version 4.1 or later receive new service books and wireless data synchronization occurs.

Advantages of this upgrade process include:

• You can move user accounts back to the previous BlackBerry Enterprise Server if you experience any issues with the new one.
• You can upgrade server hardware.
• Users experience minimal service interruptions because user accounts remain active on the previous BlackBerry Enterprise Server until you start the new one.

Disadvantages of this upgrade process include:

• You require an extra computer.
• The BlackBerry Enterprise Server sends new service books to all of the BlackBerry devices that are capable of synchronizing data over the wireless network.
Create a BlackBerry Configuration Database

If the security required by your organization does not allow applications to have permissions to create or upgrade databases, you can run the CreateDB executable on the database server to create the BlackBerry Configuration Database instead of using the setup application. After you create or upgrade the BlackBerry Configuration Database using the CreateDB executable, you can run the setup application using a Windows account with minimum requirements to the database server.

**Before you begin:** Verify that the appropriate permissions are configured on the database server.

1. Log in to the computer that hosts the database server using a local administrator account or a Windows account that has SQL administrator permissions.
2. Copy the BlackBerry Enterprise Server installation files to the database server that you want to configure as the host server for the BlackBerry Configuration Database.
3. Extract the contents to a folder on the computer.
4. Navigate to `<extracted_folder>\Database`.
5. Open the `BesMgmt.cfg` file in a text editor.
6. Change the file to include information that is specific to your organization's environment.
7. Save and close the file.
8. Open a command prompt window.
9. Change to `<extracted_folder>\Database`.
10. Type `CreateDB.exe BESMgmt.cfg`.

**BESMgmt.cfg properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMD</td>
<td>This property specifies the type of action that the CreateDB executable must complete (for example, whether to install or upgrade the BlackBerry Configuration Database).</td>
</tr>
<tr>
<td>DATABASE_NAME</td>
<td>This property specifies the name of the BlackBerry Configuration Database.</td>
</tr>
</tbody>
</table>
**Property** | **Description**
--- | ---
SERVER | This property specifies the name of the database server that hosts the BlackBerry Configuration Database. If a database instance hosts the BlackBerry Configuration Database, follow the format `database_server_name\database_instance_name`.
USERID | If you use database authentication, this property specifies the user name of the database account that has server administrator permission and database creator permission.
PASSWORD | If you use database authentication, this property specifies the password for the database account.
SCRIPT_ROOT | This property specifies the path to the DBInstallScripts folder. By default, this folder is in the same root folder that the CreateDB.exe file is located in.
LOG_DIR | This property specifies the path to the folder that you want to create log files in. By default, this folder is in the same root folder that the CreateDB.exe file is located in.
DBMS | This property specifies the database management system that your organization uses.
DB_FILE_DIR | This property specifies an existing folder that you want to save the database files in. By default, this folder is in the same root folder that the CreateDB.exe file is located in.
BACKUP_DIR | This property specifies an existing folder where you want to save the database backup in. By default, this folder is located in the same root folder that the CreateDB.exe file is located in.
BES_TYPE | This property specifies the messaging server that your organization uses.

**Install the BlackBerry Enterprise Server on a new computer and create a BlackBerry Configuration Database**

During the BlackBerry Enterprise Server installation process, you must restart the computer.

**Note:** To manage the BlackBerry Enterprise Server, you must install the BlackBerry Administration Service. You can install the BlackBerry Administration Service on the computer that hosts the BlackBerry Enterprise Server or on a separate computer. The first BlackBerry Administration Service or BlackBerry Enterprise Server that you install creates and
populates the BlackBerry Configuration Database if you did not create the BlackBerry Configuration Database previously using the SQL scripts. You must install the BlackBerry Administration Service if you create a BlackBerry Configuration Database and you must also either install or upgrade the BlackBerry Administration Service on the computer that you perform the BlackBerry Enterprise Server installation process on in the BlackBerry Enterprise Server domain first.

**Before you begin:**

Document the existing software configurations before you start the upgrade process so that you can create the software configurations again after the upgrade process is complete. For more information, see the *BlackBerry Enterprise Server Administration Guide*.

1. Log in to the computer using the Windows account that you want the BlackBerry Enterprise Server services to run on.
2. In the BlackBerry Enterprise Server installation files, double-click `setup.exe`.
3. In the **Setup type** dialog box, select **Create a BlackBerry Configuration Database**.
4. In the **Setup options** dialog box, consider the following information:
   - You can select or remove BlackBerry Enterprise Server components from the **Additional Components** list.
   - To install the BlackBerry Administration Service only during the first installation, click **Remote component**. In the **Additional components** list, expand **BlackBerry administration**. Click **BlackBerry Administration Service**.
5. If the setup application prompts you to restart the computer, click **Yes**.
6. Log in to the computer using the same account that you used in step 1.
7. In the **Database information** dialog box, perform the following actions:
   a. Specify the names of the database server and BlackBerry Configuration Database that the BlackBerry Enterprise Server uses.
   b. If you configured the database server to use static ports, select the **Static** option. If the static port number is not 1433, in the **Port** field, type the port number.
8. In the **Database mirroring options** dialog box, if you want to configure database mirroring, select the **Add support for database mirroring** check box and type the name of the database server that hosts the mirror database in the **Name of the mirror database server** field. The setup application does not create the BlackBerry Configuration Database on the mirror Microsoft SQL Server; it adds a registry key to the computer that includes the name of the mirror Microsoft SQL Server.
9. In the **CAL and SRP information** dialog box, type the new SRP credentials.
10. In the **MAPI Settings** dialog box, perform the following actions:
    a. In the **Microsoft Exchange server** field, type the name of the Microsoft Exchange server.
    b. In the **Mailbox** field, type the name of the administrator that has the appropriate permissions.
    c. Click **Check Name**.
    d. Click **OK**.
11. In the **Administration settings** dialog box, perform the following actions:
a. In the **Pool name** field, type an FQDN that the setup application can use to create the BlackBerry Administration Service web address. If you install only one BlackBerry Administration Service instance in the BlackBerry Enterprise Server domain, you can accept the default pool name. If you install more than one BlackBerry Administration Service instance in the BlackBerry Enterprise Server domain, you must create a DNS entry for the pool name that is not the name of a computer and is mapped to the IP address of each BlackBerry Administration Service instance.

b. In the **New password** and **Confirm password** fields, type the password for the SSL certificate that the BlackBerry Administration Service uses to authenticate with browsers. You must use the same password for every BlackBerry Administration Service instance in the BlackBerry Enterprise Server domain.

12. In the **Microsoft Active Directory settings** dialog box, in the **User password** field, type the password for the Microsoft Active Directory account that the BlackBerry Enterprise Server uses to authenticate with Microsoft Active Directory (for example, BESAdmin). If you want to specify a different username and Windows domain, you must make sure that the Windows domain belongs to the same Microsoft Active Directory forest as the Microsoft Exchange organization.

13. In the **Advanced administration settings** dialog box, perform one of the following actions:
   - If you select **Use Windows authentication**, you can choose to use the Microsoft Active Directory account that you used in the previous step, or you can specify login information for a Microsoft Active Directory administrator.
   - If you select **Use BlackBerry Administration Service authentication**, type and confirm a password for the BlackBerry Administration Service administrator account. Consider using the minimum rules for password complexity when you create the password for the administrator account. The password should be at least 8 characters in length and contain at least one number, letter, and special character, and should not contain dictionary words.

You use the login information that you specify to log in to the BlackBerry Administration Service for the first time.

14. In the **Start services** dialog box, do not start the BlackBerry Enterprise Server services.

15. Click **Finish**.

**After you finish:**
- Move user accounts to the BlackBerry Enterprise Server using the BlackBerry Enterprise Transporter. For more information about moving user accounts, see the *BlackBerry Enterprise Transporter Installation and Administration Guide*.

---

**Specifying a name for the BlackBerry Administration Service pool during the installation process**

During the installation process, the setup application prompts you to specify the name of the BlackBerry Administration Service pool.

The BlackBerry Administration Service instances use the pool name for interprocess communication and when you configure BlackBerry Administration Service high availability using DNS round robin. You must specify a valid DNS host name during the installation process, even if you do not configure BlackBerry Administration Service high availability using DNS round robin.
The setup application uses the FQDN of the computer that you install the first BlackBerry Administration Service instance on as the default value for the pool name. If you keep the default value and configure BlackBerry Administration Service high availability using DNS round robin at a later time, you must use the BlackBerry Configuration Panel to change the pool name to the host name for the pool.

The name for the BlackBerry Administration Service pool does not impact BlackBerry Administration Service high availability that uses a hardware load balancer.

For more information about BlackBerry Administration Service high availability, see the BlackBerry Enterprise Server Planning Guide.
Upgrading the BlackBerry Enterprise Server software in phases

If you use the phased upgrade process, you can maintain previous versions of the BlackBerry Enterprise Server software, install additional BlackBerry Enterprise Server instances over time, and move user accounts to the latest BlackBerry Enterprise Server versions.

When you use the phased upgrade process, all BlackBerry devices receive new IT policies. Devices that are running BlackBerry Device Software version 4.0 or later receive new service books and wireless data synchronization occurs.

The BlackBerry Configuration Database and all BlackBerry Administration Service instances in the BlackBerry Enterprise Server domain must be the same version. Before you upgrade the BlackBerry Configuration Database, you must stop the BlackBerry Administration Service services that run on all other computers in the BlackBerry Enterprise Server domain until you upgrade the computers.

Advantages of the phased upgrade process include:

- You can move user accounts to the new BlackBerry Enterprise Server instances gradually to limit the number of service books and IT policies that the BlackBerry Policy Service sends to devices at the same time.
- You can monitor system performance while you add user accounts.
- You can change your organization’s environment during the upgrade process by changing which user accounts you associate with each BlackBerry Enterprise Server instance.

Disadvantages of this upgrade process include:

- You require extra computers.
- You require additional SRP credentials.
- If you move user accounts from one BlackBerry Configuration Database to another, you lose the device options that you backed up in the BlackBerry Configuration Database.
- You cannot use some new features (for example, one-to-many relationships between a BlackBerry MDS Connection Service or BlackBerry Collaboration Service and multiple BlackBerry Enterprise Server instances) in the BlackBerry Enterprise Server until all BlackBerry Enterprise Server components are the same version.
Upgrade multiple BlackBerry Enterprise Server instances in phases

You can upgrade the BlackBerry Enterprise Server instances in your organization's environment in phases to minimize the impact on users.

**Before you begin:** If you want to create a new BlackBerry Configuration Database, instruct users to back up their BlackBerry devices. Any BlackBerry device options that are stored in the existing BlackBerry Configuration Database are deleted when you add user accounts to the new BlackBerry Configuration Database.

1. Install the latest BlackBerry Enterprise Server version with the BlackBerry Administration Service on a separate computer.
2. If you create a new BlackBerry Configuration Database, create roles, administrator accounts, groups, IT policies, and software configurations for your organization's environment.
3. If you upgrade an existing BlackBerry Configuration Database, remove BlackBerry Manager instances from your organization's environment.
4. Move user accounts to the upgraded BlackBerry Enterprise Server by performing one of the following actions:
   - To upgrade an existing BlackBerry Configuration Database, move user accounts using the BlackBerry Administration Service.
   - To create a new BlackBerry Configuration Database, move user accounts using the BlackBerry Enterprise Transporter.
5. Upgrade instances of the central push server for the BlackBerry MDS Connection Service.
6. Upgrade the earlier BlackBerry Enterprise Server version using an in-place upgrade process. You can use the upgraded BlackBerry Enterprise Server instance as the destination for user accounts that you move from earlier BlackBerry Enterprise Server versions.
7. Move user accounts to the upgraded BlackBerry Enterprise Server instances, and upgrade the old BlackBerry Enterprise Server instances until all BlackBerry Enterprise Server instances are running the latest software version.

**After you finish:** To enable BlackBerry device users to access the features that are part of the latest version, upgrade the BlackBerry Device Software. For more information, see the *BlackBerry Device Software Update Guide*. 
Upgrade a standalone BlackBerry Router

**Note:** You cannot manage the BlackBerry Controller that monitors a standalone BlackBerry Router in the BlackBerry Administration Service. You must manage the BlackBerry Controller in the BlackBerry Configuration Panel on the computer that hosts the standalone BlackBerry Router.

1. Log in to the computer using the Windows account that you want to use to run the BlackBerry Router.
2. In the BlackBerry Enterprise Server installation files, double-click **Setup.exe**. If the operating system in your organization’s environment is Windows Server 2008 or later, run **setup.exe** as an administrator.
3. In the **Setup type** dialog box, select **Upgrade the BlackBerry Router and BlackBerry Controller on this computer but do not install other BlackBerry Enterprise Server components**.
4. In the **Start services** dialog box, click **Start Services**. When all of the BlackBerry Enterprise Server Express services start, click **Next**.
5. In the **Console addresses** dialog box, click **Finish**. By default, the setup application writes the BlackBerry Administration Service and the BlackBerry Web Desktop Manager web addresses to a .txt file.

Test the connection from the BlackBerry Router to the BlackBerry Infrastructure

To make sure that the BlackBerry Router can connect to the BlackBerry Infrastructure, you can test the connection using the BBSRPTest tool that is included with the BlackBerry Enterprise Server installation files. The BBSRPTest tool tries to connect to the BlackBerry Infrastructure using the SRP address and SRP port that you specified for the BlackBerry Infrastructure during the BlackBerry Router installation process.

1. On the computer that you want to test the connection to the BlackBerry Infrastructure on, at a command prompt, navigate to `<drive>:\Program Files\Research In Motion\BlackBerry Enterprise Server`.
2. Type **bbsrptest <srp_address> -<port>**, where `<srp_address>` is the SRP address that you provided during the installation process and `<port>` is the SRP port number. For example, at the command line, type **bbsrptest.exe –host server1.example.com –port 3101**.

**After you finish:** If the test does not complete, use the Windows Socket (WINSOCK) error code to diagnose the problem. For more information, visit [http://msdn.microsoft.com](http://msdn.microsoft.com) to read article **Windows Socket Error Codes**.
Postupgrade tasks

Resend the database mirroring parameters to BlackBerry Enterprise Server components

If the computers that host BlackBerry Enterprise Server components were not running or connected to the network when you configured the BlackBerry Enterprise Solution to support database mirroring, or if you do not know if all of the components were configured to support database mirroring, you should resend the database mirroring parameters to the components. When you resend the database mirroring parameters, the BlackBerry Administration Service adds a registry key to the computers that host the components. The registry key includes the name of the Microsoft SQL Server that hosts the mirror database.

**CAUTION:** If you resend the database mirroring parameters more than once but you do not restart the BlackBerry Enterprise Server services or the computers that host the BlackBerry Enterprise Server components that the BlackBerry Administration Service specifies as Updated, you should restart the BlackBerry Enterprise Server services or restart the computers for all of the BlackBerry Enterprise Server components.

**Before you begin:** The database server that hosts the mirror database must be running.

1. In the BlackBerry Administration Service, on the **Servers and components** menu, go to **BlackBerry Solution Topology > BlackBerry Domain**.
2. Click **Resend database mirroring parameters**.
3. On the computers that host the BlackBerry Enterprise Server components that are specified as Updated in the **Server responses to mirroring data update** table, restart the BlackBerry Enterprise Server services or restart the computers that host the components.
4. On the computers that host the BlackBerry Enterprise Server components that are specified as No response. Please save the data again to attempt to update this server, verify that the computers are running and connected to the network and then resend the database mirroring parameters to the BlackBerry Enterprise Server components.
Restore the BlackBerry MDS Connection Service configuration files

You can use the BlackBerry MDS Connection Service configuration files, MdsLogin.conf and krb5.conf, to configure how the BlackBerry MDS Connection Service authenticates BlackBerry devices with content servers that use NTLM or Kerberos. The BlackBerry MDS Connection Service configuration files are located in `<drive>:\Program Files\Research In Motion\BlackBerry Enterprise Server\MDS\Servers\Instance\config`.

When you upgrade a BlackBerry Enterprise Server, the setup application creates new MdsLogin.conf or krb5.conf files and creates backup versions of the old BlackBerry MDS Connection Service configuration files in the same location. If you changed the MdsLogin.conf or krb5.conf files before you perform the upgrade, you should restore the backup versions of the files so that the BlackBerry MDS Connection Service can authenticate BlackBerry devices with the content servers that use NTLM or Kerberos.

Upgrade the BlackBerry database notification system

The BlackBerry database notification system is a publish/subscribe system that is designed to reduce the number of database queries that a BlackBerry Enterprise Server makes to the BlackBerry Configuration Database.

If you upgrade the BlackBerry Configuration Database on the computer that hosts the BlackBerry Enterprise Server, the BlackBerry database notification system upgrades automatically.

If you upgrade the BlackBerry Configuration Database on a database server that you installed on a computer that is not the computer that hosts the BlackBerry Enterprise Server, you can upgrade the BlackBerry database notification system manually after you complete the BlackBerry Enterprise Server installation process.

**Before you begin:**

You must have the system administrator permission for the database.

1. On the database server, open the BlackBerry Enterprise Server installation files.
2. Perform one of the following actions:
   - If a 32-bit Microsoft SQL Server 2005 is running in your organization's environment, in the `Tools\DBNS\x86` folder, copy the `RimEsp.dll` file to `C:\Program Files\Microsoft SQL Server\MSSQL\Binn`.
   - If a 64-bit Microsoft SQL Server 2005 is running in your organization's environment, in the `Tools\DBNS\x64` folder, copy the `RimEsp.dll` file to `C:\Program Files\Microsoft SQL Server\MSSQL\Binn`. 
3. Open the Microsoft SQL Server Management Studio.

4. Using the Microsoft SQL Server Management Studio, navigate to Database\DBInstallScripts\SQLServer\5.0 in the BlackBerry Enterprise Server installation files.

5. Open the NotifyMasterInstall.sql file.

6. Run the script.

7. Open the NotifyInstall.sql file.

8. Change <_DATABASENAME_> to the name of the BlackBerry Configuration Database (for example, BesMgmt).

9. Run the script.

10. Confirm that the Microsoft SQL Server Management Studio displays the Function dbo.xp_RIMxxxx registered message.

11. To add additional BlackBerry Configuration Database instances in your organization's environment, repeat steps 7 to 10.

12. Restart the database server and the computer that hosts the BlackBerry Enterprise Server.

---

### Best practice: Running the BlackBerry Enterprise Server

<table>
<thead>
<tr>
<th>Best practice</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not change the startup type for the BlackBerry Enterprise Server services.</td>
<td>When you install or upgrade the BlackBerry Enterprise Server, the setup application configures the startup type for the BlackBerry Enterprise Server services to automatic or manual. For example, the setup application configures the startup type for the BlackBerry Mail Store Service, BlackBerry Policy Service, and BlackBerry Synchronization Service to manual. To avoid errors in the BlackBerry Enterprise Server, do not change the startup type for the BlackBerry Enterprise Server services.</td>
</tr>
<tr>
<td>Do not change the account information for BlackBerry Enterprise Server services.</td>
<td>When you install or upgrade the BlackBerry Enterprise Server, the setup application configures the account information for the BlackBerry Enterprise Server services. Do not change the account information for the BlackBerry Enterprise Server unless the BlackBerry Enterprise Server documentation specifies that you can.</td>
</tr>
<tr>
<td>Run the BlackBerry Configuration Panel as an administrator.</td>
<td>Consider the following guidelines if you are running the BlackBerry Configuration Panel on Windows Server 2008:</td>
</tr>
</tbody>
</table>
You can make sure that the messaging application can display the Unicode messages that the BlackBerry device sends by configuring the BlackBerry Enterprise Server to support Unicode languages (for example, Japanese, Korean, or Simplified Chinese).

1. On the computer that hosts the BlackBerry Enterprise Server, on the taskbar, click **Start > Run**.
2. Type `regedit`.
3. Click **OK**.
4. Perform one of the following actions:
   - If you are running a 32-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion \BlackBerry Enterprise Server\Agents.
   - If you are running a 64-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node \Research In Motion\BlackBerry Enterprise Server\Agents.
5. If the **MAPIEncoding** registry key exists, perform one of the following actions:
   - Delete the key.
   - Change the value of the key to **1**.
6. Perform one of the following actions:
   - If you are running a 32-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion \BlackBerry Enterprise Server\Setup.
   - If you are running a 64-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node \Research In Motion\BlackBerry Enterprise Server\Setup.
7. Verify that the **ConfigKeystoreCountry** registry key is set to one of the following values, depending on your organization’s environment:
   - CN for Simplified Chinese
8. In the Windows Services, restart the BlackBerry Dispatcher.

Change the character encoding that the BlackBerry Enterprise Server uses to send Unicode messages

By default, when the BlackBerry Enterprise Server receives Unicode messages from BlackBerry devices, it uses UTF-8 character encoding to process the Unicode messages. If email applications cannot correctly display Unicode messages that devices send (for example, if email applications cannot display attachment file names or contact lists correctly), you can configure the BlackBerry Enterprise Server to select another character encoding to use to process Unicode messages.

**Before you begin:** Configure support for Unicode languages.

1. On the computer that hosts the BlackBerry Enterprise Server, on the taskbar, click Start > Run.
2. Type `regedit`.
3. Click OK.
4. Perform one of the following actions:
   - If you are running a 32-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion\BlackBerry Enterprise Server\Agents.
   - If you are running a 64-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Research In Motion\BlackBerry Enterprise Server\Agents.
5. Create a DWORD value that is named `AutoSelectOutgoingEncoding`.
6. Double-click the new DWORD value.
7. In the Value data field, perform one of the following actions:
   - To configure the BlackBerry Enterprise Server to select the most appropriate character encoding when it encodes plain-text messages, type 1. If the BlackBerry Enterprise Server cannot identify which character encoding to use, the BlackBerry Enterprise Server encodes plain-text messages in UTF-8.
   - To configure the BlackBerry Enterprise Server to select the most appropriate character encoding when it encodes email messages that use RTF or HTML, type 2. If the BlackBerry Enterprise Server cannot identify which character encoding to use, the BlackBerry Enterprise Server encodes email messages that use RTF or HTML in UTF-8.
   - To configure the BlackBerry Enterprise Server to select the most appropriate character encoding when it encodes plain-text messages and email messages that use RTF or HTML, type 3. If the BlackBerry Enterprise Server cannot identify which character encoding to use, the BlackBerry Enterprise Server encodes all email messages in UTF-8.
8. In the Windows Services, restart the BlackBerry Dispatcher.
Configure the BlackBerry Enterprise Server to use only UTF-8 to send Unicode messages

To make sure that the BlackBerry Enterprise Server uses only UTF-8 character encoding to process Unicode messages that it receives from BlackBerry devices, complete the following steps.

1. On the computer that hosts the BlackBerry Enterprise Server, on the taskbar, click Start > Run.
2. Type regedit.
3. Click OK.
4. Perform one of the following actions:
   • If you are running a 32-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion\BlackBerry Enterprise Server\Agents.
   • If you are running a 64-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Research In Motion\BlackBerry Enterprise Server\Agents.
5. Create a DWORD value that is named MAPIEncoding.
6. In the Value data field, type 0 and click OK.
7. Create a DWORD value that is named AutoSelectOutgoingEncoding.
8. In the Value data field, type 0 and click OK.
9. In the Windows Services, restart the BlackBerry Dispatcher.

Configure support for Unicode text in calendars on BlackBerry devices in a Microsoft Exchange environment

Before you begin: In a Microsoft Exchange 2003 environment, install the following hotfixes for wireless calendar synchronization:
• Visit http://support.microsoft.com/kb/913643 to download and install the required hotfix on the messaging server.
• Visit http://support.microsoft.com/kb/923537/en-us to download and install the required hotfix on the computer that will host the BlackBerry Enterprise Server.

You must complete this task for all Microsoft Exchange versions to ensure calendar items use the correct Unicode characters in fields such as subject, location, or notes.

1. On the BlackBerry Enterprise Server, on the Start menu, click Run.
2. Type `regedit`.
3. Click **OK**.
4. Perform one of the following actions:
   - If you are running a 32-bit version of Windows, navigate to `HKEY_LOCAL_MACHINE\Software\Research In Motion \Blackberry Enterprise Server\Agents`.
   - If you are running a 64-bit version of Windows, navigate to `HKEY_LOCAL_MACHINE\Software\WOW6432Node \Research In Motion\Blackberry Enterprise Server\Agents`.
5. Create a DWORD value that is named **SetLocaleIDs**.
6. Set the value to 1.
7. In the Windows Services, restart the BlackBerry Messaging Agent.

**Configuring the BlackBerry Enterprise Server to use Microsoft Exchange Web Services**

By default, the BlackBerry Enterprise Server uses Microsoft Exchange Web Services to manage calendars on BlackBerry devices. The BlackBerry Enterprise Server monitors periodically whether a user account can use Microsoft Exchange Web Services. If a user account cannot use Microsoft Exchange Web Services, for example, because of a configuration error in Microsoft Exchange, the BlackBerry Enterprise Server uses MAPI and CDO libraries to manage calendars on devices. A BlackBerry Messaging Agent on the BlackBerry Enterprise Server can include a dynamic mix of user accounts that use Microsoft Exchange Web Services and user accounts that use MAPI and CDO libraries.

You can use the BlackBerry Enterprise Trait Tool to configure the BlackBerry Enterprise Server to use only Microsoft Exchange Web Services or only MAPI and CDO libraries to manage calendars on devices. You can configure a specific BlackBerry Messaging Agent instance, a specific BlackBerry Enterprise Server instance, or all BlackBerry Enterprise Server instances that share one BlackBerry Configuration Database.

To use Microsoft Exchange Web Services, your organization’s environment must include Microsoft Exchange 2007 SP1 or later.


For more information about configuring the BlackBerry Enterprise Server to use Microsoft Exchange Web Services, see the *BlackBerry Enterprise Server Administration Guide*.
Prerequisites: Configuring the BlackBerry Enterprise Server to use Microsoft Exchange Web Services

- Install an SSL certificate on a BlackBerry Enterprise Server so that the BlackBerry Enterprise Server can communicate with Microsoft Exchange Web Services. You must export the SSL certificate from the client access server for Microsoft Exchange and import the SSL certificate to the BlackBerry Enterprise Server. The BlackBerry Enterprise Server supports a self-signed security certificate or a certificate that a certificate authority issues. For more information about installing an SSL certificate, visit support.microsoft.com to read article KB 962624.


- Assign IIS permissions to a BlackBerry Enterprise Server administrator account on the Microsoft Exchange Server that hosts the client access server role. For more information about assigning IIS permissions, visit support.microsoft.com to read article KB 816117.

Configure the BlackBerry Enterprise Server to use Microsoft Exchange Web Services

You can configure the BlackBerry Enterprise Server to use only Microsoft Exchange Web Services to manage calendars on BlackBerry devices.

1. Copy the BlackBerry Enterprise Server installation files to the computer that hosts the primary BlackBerry Enterprise Server.

2. Extract the contents to a folder on the computer.

3. At a command prompt, navigate to extracted_folder\tools.

4. Perform one of the following actions:
   - To configure a specific BlackBerry Messaging Agent on a specific BlackBerry Enterprise Server to use Microsoft Exchange Web Services, type traittool -server <server_name> -agent <agent_id> -trait EWSEnable -set true, where <server_name> is the name of the BlackBerry Enterprise Server and <agent_id> is the ID for the BlackBerry Messaging Agent. If you configured high availability, configure only the primary BlackBerry Enterprise Server.

   - To configure all BlackBerry Messaging Agent instances on a specific BlackBerry Enterprise Server to use Microsoft Exchange Web Services, type traittool -server <server_name> -trait EWSEnable -set true, where <server_name> is the name of the BlackBerry Enterprise Server. If you configured high availability, configure only the primary BlackBerry Enterprise Server.
• To configure all BlackBerry Messaging Agent instances on all BlackBerry Enterprise Server instances to use Microsoft Exchange Web Services, type `traittool -global -trait EWSEnable -set true`.

5. Restart the BlackBerry Messaging Agent instances that you made changes to.

After you finish:

In the logs folder verify that the file named `<server_name>_CALH_<agent_id>_<date>.txt` appears. In the file name, `<server_name>` is the name of the BlackBerry Enterprise Server, `<agent_id>` is the ID of the BlackBerry Messaging Agent, and `<date>` is the date that you configured the BlackBerry Enterprise Server to use Microsoft Exchange Web Services.

Manage the BlackBerry Enterprise Server performance in a Microsoft Exchange 2010 environment

Before you begin:

You must install version 6.5.8211.0 of the Microsoft Exchange Server MAPI Client and CDO 1.2.1 on the BlackBerry Enterprise Server computer. For more information, visit [www.microsoft.com/downloads](http://www.microsoft.com/downloads) to read the article named "Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1".

1. Verify that you configured Microsoft Exchange 2010 performance as suggested by Microsoft. For more information, visit [technet.microsoft.com](http://technet.microsoft.com) to read "Understanding the Mailbox Database Cache" in the Microsoft Exchange 2010 SP1 help.

2. If necessary for your organization’s environment, verify that you installed the Microsoft hotfixes that are located in the following articles:
   - 2155311
   - 979149
   For more information about the hotfixes, visit [support.microsoft.com](http://support.microsoft.com).

3. Configure the BlackBerry Enterprise Server to use Microsoft Exchange Web Services to manage calendars on devices. For more information, see "Configuring the BlackBerry Enterprise Server to use Microsoft Exchange Web Services or MAPI and CDO libraries" in the *BlackBerry Enterprise Server Administration Guide*. BlackBerry Enterprise Server defaults to using LDAP to retrieve email addresses and organizer data upon installation.
Configure a Hosted BlackBerry services environment for use with Microsoft Exchange 2010 SP1 Multi-Tenant Deployment

1. Verify that you configured the Microsoft Exchange 2010 messaging environment and completed the tasks "Configure a management role for Microsoft Exchange Web Services" and "Configure the BlackBerry Enterprise Server to run without public folders". For more information, see "Configuring a Microsoft Exchange 2010 messaging environment".

2. Configure Hosted BlackBerry services. If possible, make sure that your organization’s customers have full control of their subtree in Microsoft Active Directory. For more information, see "Configure Hosted BlackBerry services when your organization’s customers have full control of their subtree in Microsoft Active Directory" in the BlackBerry Enterprise Server Administration Guide.

Configure the BlackBerry Administration Service instances in a pool to communicate across network subnets

The instances in the BlackBerry Administration Service pool use multicast UDP to communicate with each other. If the BlackBerry Administration Service instances are located in different network subnets and your organization’s network configuration does not permit multicast UDP across the network subnets, you must configure the BlackBerry Administration Service instances to use TCP to communicate with each other. For example, if your organization uses a UDP peer-to-peer firewall filter, you must configure the BlackBerry Administration Service instances to use TCP to communicate across the network subnets.

1. Make sure that no BlackBerry Administration Service instance is in the process of starting.

2. In the BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution topology > BlackBerry Domain > Component view > BlackBerry Administration Service.

3. Click Edit component.
4. In the **BlackBerry Administration Service pool** drop-down list, click **TCP with TCP PING**.

5. Click **Save all**.

6. Restart the BlackBerry Administration Service instances.

---

## Log in to the BlackBerry Administration Service for the first time

To open the BlackBerry Administration Service, you can use a browser on any computer that has access to the computer that hosts the BlackBerry Administration Service.

**Before you begin:** To manage a BlackBerry device using the BlackBerry Administration Service while the BlackBerry device is connected to the computer, the browser must permit Microsoft ActiveX controls.

1. In the **User name** field, type **admin**.

2. In the **Password** field, type the password that you created during the installation process.

3. In the **Log in using** drop-down list, click **BlackBerry Administration Service** or **Active Directory Authentication**.

4. Click **Log in**.

---

## There is a problem with this website's security certificate

### Description

The browser displays this error message when you try to navigate to the BlackBerry Administration Service using Windows Internet Explorer version 7 or later.

### Possible solution

Add the web address for the BlackBerry Administration Service to the list of trusted web sites in Windows Internet Explorer, and install the certificate for the BlackBerry Administration Service in the certificate store of your computer.

1. In Windows Internet Explorer, navigate to the BlackBerry Administration Service console.

2. Click **Continue to this website (not recommended)**.

3. On the **Tools** menu, click **Internet Options**.
5. Click Sites.
6. Click Add to add the console to the list of trusted web sites.
7. Click Close.
8. Click OK.
9. In the browser window, on the toolbar, click Certificate Error.
10. Click View certificates.
12. Complete the instructions in the Certificate Import Wizard. If you are trying to log in to the BlackBerry Administration Service using a computer that runs Windows Vista, perform the following actions in the Certificate Import Wizard.
   a. In the Certificate Store dialog box, click Place all certificates in the following store.
   b. Click Browse.
   c. Click Trusted Root Certification Authorities.
   d. Click OK.
13. Close and reopen the browser.

Change applications to support BlackBerry MDS Connection Service failover

In earlier versions of the BlackBerry Enterprise Server, an organization's push applications connected to only one instance of the BlackBerry MDS Connection Service central push server. You must make sure that your organization's applications can access all central push servers.

1. Change the applications to access central push servers only, and not BlackBerry MDS Connection Service instances that administrators have not configured to also act as central push servers.
2. To change your organization’s applications to support central push server failover, perform one of the following actions:
   • Configure an HTTP or HTTPS proxy server that applications send requests through. Use this option if the applications are located on the Internet. Optionally, you can place the proxy server in the DMZ.
   • Configure the application servers to use a list of IP addresses to find an available central push server. If a central push server does not respond to a request, the application can try to connect to another central push server.
• Configure a hardware load balancer. The load balancer accepts all requests from the application servers, and distributes the traffic to the various central push servers. If a central push server does not respond, the load balancer redistributes the requests to the remaining central push servers.

• Configure the application to use the new HTTP response header x-rim-push-gateways.

Configuring support for new attachments

Configure an upgraded BlackBerry Enterprise Server to support new attachment extensions

When you upgrade a BlackBerry Enterprise Server instance, the upgrade process does not automatically add the new attachment extensions that the latest BlackBerry Enterprise Server version supports. You must add the new attachment extensions after the upgrade process completes so that the BlackBerry Enterprise Server can recognize the new attachment extensions and send them to a BlackBerry Attachment Service instance for processing.

1. In the BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution topology > BlackBerry Domain > Component view > Attachment > Connector.

2. Click the BlackBerry Attachment Connector instance for the BlackBerry Enterprise Server.

3. Click Edit instance.

4. Click Supported Attachment Server instances.

5. For the BlackBerry Attachment Service instance that you want the BlackBerry Enterprise Server to send new attachments to, click the Edit icon.

6. Add the new attachment extensions to the attachment extensions list.

7. Click Save all.

Configure an upgraded BlackBerry Attachment Service to support new attachment distillers

During the upgrade process for a BlackBerry Attachment Service instance, the setup application does not turn on the new attachment distillers automatically. If you want the BlackBerry Attachment Service to process new attachments, you must turn on the attachment distillers for these file formats.

1. In the BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution topology > BlackBerry Domain > Component view > Attachment > Server.
2. Click the instance that you upgraded.
3. Click **Edit instance**.
4. In the **Distiller** section, in the **Allowed** column, turn on the attachment distillers that you want the BlackBerry Attachment Service to support.
5. If required, in the **Distiller** section, in the **Attachment size (KB)** column, change the attachment size, in KB, for the new attachments.
6. Click **Save**.

### Assigning an IT policy to a group

After you complete the upgrade process, you can assign an IT policy to a group. When you assign an IT policy to a group, the BlackBerry Enterprise Server can assign the IT policy to each user account in the group. However, if an IT policy is already assigned to a user account in a group, the BlackBerry Enterprise Server sends the IT policy that is assigned to the user account to the BlackBerry device. To use the IT policy that is assigned to the group, you must remove the IT policy that is assigned to the user account.

### Remove an IT policy from a user account

**Before you begin:** Assign an IT policy to a group that includes the user account.

1. In the BlackBerry Administration Service, on the **BlackBerry solution management** menu, expand **User**.
2. Click **Manage users**.
3. Search for the user account.
4. Click the user account.
5. On the **Policies** tab, click **Edit user**.
6. In the drop-down list, click the blank option (the first entry in the drop-down list) to remove the IT policy.
7. Click **Save all**.

**After you finish:** Resend the IT policy to the user account.
Configuring a computer for monitoring

Configure the SNMP service for monitoring by a monitoring application

You can configure the SNMP service on the computer that hosts the BlackBerry Enterprise Server so that a monitoring application can monitor BlackBerry Enterprise Server activity.

Before you begin: Verify that the SNMP service is installed and running.

1. On a computer that hosts the BlackBerry Enterprise Server or BlackBerry Enterprise Server components, in the Windows Services, right-click **SNMP Service**. Click **Properties**.

2. On the **General** tab, change the startup type to **Automatic**.

3. On the **Traps** tab, in the **Community name** field, type the community name for the SNMP service. The field is case-sensitive.

4. In the **Trap Destinations** section, add the IP address of the computer that hosts the monitoring application.

5. On the **Security** tab, in the **Accepted community names** section, add the community name that you typed in step 3. The SNMP community name is read-only.

6. Select the **Accept SNMP packets from any host** or **Accept SNMP packets from these hosts** option, depending on your organization’s environment.

7. If you selected **Accept SNMP packets from these hosts**, type the IP address of the computer that hosts the monitoring application.

8. Click **Apply**.

9. In the **Services** list, right-click **SNMP Service**. Click **Restart**.

Restrict database permissions for the BlackBerry Attachment Service

The BlackBerry Attachment Service accesses the BlackBerry Configuration Database to read attachment data using a Windows account or a SQL authentication account. To limit the access that the BlackBerry Attachment Service account
has to the tables in the BlackBerry Configuration Database, you can configure a BlackBerry Attachment Service account that has limited database permissions. This account is not the same as the account that the BlackBerry Enterprise Server uses to access the BlackBerry Configuration Database.

**Before you begin:**

- Create a Windows account for the BlackBerry Attachment Service.
- To use database authentication, create a SQL authentication account for the BlackBerry Attachment Service.

1. In the Microsoft SQL Server management console, create a SQL login for the Windows account or SQL authentication account.
2. Assign the account to the rim_db_AttachmentServer role in the BlackBerry Configuration Database.
3. If you want the BlackBerry Attachment Service to use a SQL authentication account to access the BlackBerry Configuration Database, perform the following actions:
   a. On the computer that you installed the BlackBerry Attachment Service on, log in using the Windows account that the BlackBerry Attachment Service is running on.
   b. Click **Start > Run**.
   c. Type `regedit`. Click **OK**.
   d. If you are running a 32-bit version of Windows, navigate to HKEY_CURRENT_USER\SOFTWARE\Research In Motion.
   e. If you are running a 64-bit version of Windows, navigate to HKEY_CURRENT_USER\SOFTWARE\WOW6432Node\Research In Motion.
   f. Create the BBAttachServer\Database keys.
   g. In the Database key, create the **Login** and **Password** string values for the SQL authentication account.

**After you finish:** After you complete the BlackBerry Attachment Service installation process, in the Windows Services, verify that the service for the BlackBerry Attachment Service is using the Windows account that you configured. If you need to change the account information, restart the BlackBerry Attachment Service.

### Configuring minimum Microsoft SQL Server permissions for the Windows account

The BlackBerry Enterprise Server setup application requires the Windows account that it uses during the installation process or upgrade process to have Microsoft SQL Server permissions to create or upgrade the BlackBerry Configuration Database. The setup application requires the Windows account to have more Microsoft SQL Server permissions to install the BlackBerry Enterprise Server than the BlackBerry Enterprise Server requires to run.
After the installation or upgrade process completes, you can change the Microsoft SQL Server permissions of the Windows account to the Microsoft SQL Server permissions that the BlackBerry Enterprise Server requires to run. When you change the Microsoft SQL Server permissions of the Windows account, you can use Microsoft SQL Server security to minimize the operations that the Windows account can perform on the BlackBerry Configuration Database.

The following table describes the Microsoft SQL Server permissions for the setup application and the Windows account that the BlackBerry Enterprise Server uses to run.

<table>
<thead>
<tr>
<th>Server and database roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>db_owner</td>
<td>The setup application requires this role to upgrade the BlackBerry Configuration Database. This role is the default permission in Microsoft SQL Server for running the BlackBerry Enterprise Server.</td>
</tr>
<tr>
<td>rim_db_bes_server</td>
<td>The setup application or the createDB executable creates the role automatically when it creates the BlackBerry Configuration Database. This role is the minimum permission in Microsoft SQL Server for running the BlackBerry Enterprise Server.</td>
</tr>
</tbody>
</table>

**Configure minimum Microsoft SQL Server permissions for the Windows account**

You can configure the minimum Microsoft SQL Server permissions for the Windows account that the BlackBerry Enterprise Server uses to run.

1. Open the Microsoft SQL Server console.
2. Expand **Microsoft SQL Server > Security > Logins**.
3. Right-click the Windows account that the BlackBerry Enterprise Server uses to run. Click **Properties**.
4. Map the Windows account to the BlackBerry Configuration Database.
5. Change the **Database role membership** to **rim_db_bes_server**.
6. Remove all other database role memberships.
7. Apply your changes.
Provisioning the BlackBerry Collaboration Service as a trusted application

If you install Microsoft Office Communications Server 2007 R2 or Microsoft Lync Server 2010 for instant messaging, you must provision the BlackBerry Collaboration Service as a trusted application in Microsoft Active Directory.

If you add the Windows account that runs the BlackBerry Collaboration Service to the RTCUniversalServerAdmins group, the BlackBerry Collaboration Service is automatically provisioned as a trusted application. The RTCUniversalServerAdmins group is created when you install Microsoft Office Communications Server 2007 R2 or Microsoft Lync Server 2010.

If you do not add the Windows account that runs the BlackBerry Collaboration Service to the RTCUniversalServerAdmins group, you must manually provision each BlackBerry Collaboration Service instance as a trusted application. If you change the listening port number or if the FQDN of the instant-messaging pool changes, you need to repeat the manual provisioning task. If you restart the BlackBerry Collaboration Service, you do not need to repeat the manual provisioning task.

Manually provision the BlackBerry Collaboration Service as a trusted application

Before you begin:
• Make sure that the Windows account that you use to complete this task is a member of the RTCUniversalServerAdmins group or a group with similar permissions.
• Turn off automatic configuration of the BlackBerry Collaboration Service as a trusted application.

1. On the computer that hosts the BlackBerry Collaboration Service or on any computer that is in the BlackBerry Enterprise Server domain, navigate to C:\Program Files (x86)\Research In Motion\BlackBerry Enterprise Server\BBIM\bin.
2. Run the BCSProvisioner.exe file.
3. In the BCSProvisioner dialog box, perform the following actions to complete the provisioning process:
   a. In the Office Communications Server Pool drop-down box, select the FQDN that you specified during the BlackBerry Enterprise Server installation.
   b. In the BlackBerry Collaboration Service server FQDN field, type the FQDN of the computer that hosts the BlackBerry Collaboration Service.
   c. In the Listening port field, type the port number that you specified during the BlackBerry Enterprise Server installation. The default port number is 65061.
d. Click **Provision BCS**.

4. In the Windows Services, restart the BlackBerry Collaboration Service.

---

**Turn off automatic provisioning of the BlackBerry Collaboration Service as a trusted application**

If you install Microsoft Office Communications Server 2007 R2 or Microsoft Lync Server 2010 for instant messaging and you want to manually provision the BlackBerry Collaboration Service as a trusted application in Microsoft Active Directory, you must first turn off automatic provisioning.

**Before you begin:** Make sure that the Windows account that runs the BlackBerry Collaboration Service is a member of either the RTComponentUniversalServices group or the RTCUniversalServerAdmins group.

1. On the computer that hosts the BlackBerry Collaboration Service, navigate to `<drive>:\Program Files (x86)\Research In Motion\BlackBerry Enterprise Server\BBIM\Servers\instance\config`.
2. In a text editor, open the `rimpublic.property` file.
3. At the end of the file, type `improxy.RIMMSCConnector.autoprovision=false`.
4. Save and close the `rimpublic.property` file.
5. In the Windows Services, restart the BlackBerry Collaboration Service.
Troubleshooting the BlackBerry Enterprise Server upgrade process

Failed to write License Key to the Database

This error message appears when you try to add the BlackBerry Client Access License key during the installation process.

Possible solution
After you restart the computer during the BlackBerry Enterprise Server installation process, you must log in using the same Windows account that you used to start the installation process.

1. Close the setup application.
2. Log out of the computer.
3. Log in to the computer.
4. Restart the setup application.

Previous version detected but no database available

This error message appears when you cannot start the setup application or the setup application stops responding.

Possible solution
Verify that the registry keys that identify the BlackBerry Configuration Database exist in the Windows registry.

1. On the computer that you want to install or upgrade the BlackBerry Enterprise Server on, on the Start menu, click Run.
2. Type regedit.
3. Click OK.
4. In the left pane, navigate to HKEY_LOCAL_MACHINE\Software\Research In Motion\BlackBerry Enterprise Server \Database.
5. If necessary, create case-sensitive strings that you name DatabaseName and DatabaseServerMachineName.
6. Specify the name of the BlackBerry Configuration Database as the value for DatabaseName.
7. Specify the FQDN name of the database server as the value for DatabaseServerMachineName.
8. Restart the setup application.

You encounter errors when you try to upgrade the BlackBerry Configuration Database

Possible solution
1. Navigate to C:\Program Files\Research In Motion\BlackBerry Enterprise Server\Logs\Installer or to the location of the log files that you specified in the setup application.
2. Open DB_InstallV<YYMMDDHHMMSS>.log, where <YYMMDDHHMMSS> specifies the date and time, in 24-hour clock format, that you upgraded the BlackBerry Configuration Database.
3. Check the log file for error messages.

You cannot resolve errors that occur when you move users

Possible solution
1. Delete the user accounts from the BlackBerry Enterprise Server before you start the upgrade process.
2. Add the user accounts to the BlackBerry Enterprise Server when the upgrade process completes.
3. Activate users’ BlackBerry devices over the wireless network.
A third-party tool did not install and the BlackBerry Enterprise Server setup application closed

Possible solution
1. On the BlackBerry Enterprise Server installation media, open the Tools folder.
2. Double-click the setup application file for the tool that you want to install.
3. Complete the instructions on the screen.
4. Restart the BlackBerry Enterprise Server setup application.

The BlackBerry Collaboration Service does not connect to Microsoft Office Live Communications Server 2005

Possible solution
If the instant messaging in your organization's environment supports Windows Messenger with TLS, you must configure authentication.
2. Install Microsoft Office Communicator 2005 on the computer that hosts the BlackBerry Collaboration Service.
4. If a connection does not open, verify that you installed or imported the certificates that are required for authentication.
The setup application did not prompt you to change or confirm the MAPI profile

Possible solution
Create and change the MAPI profile manually.
1. On the BlackBerry Enterprise Server installation media, open the Tools folder.
2. Double-click the Fixmapisvc.exe file.
3. Verify that mapisvc.inf is installed in C:\winnt\system32\ or C:\windows\system32\. 
4. On the taskbar, click Start > BlackBerry Enterprise Server > Edit MAPI Profile.
5. Type the Microsoft Exchange server name.
6. Click the Windows account that is associated with the MAPI profile.
7. Click OK.

Restore a BlackBerry Configuration Database

If you created a copy of the BlackBerry Configuration Database using the CreateDB tool, you can restore the copy if you determine that the upgrade process did not complete successfully.
1. In the Windows Services, stop the BlackBerry Enterprise Server services.
2. On the server that hosts the BlackBerry Configuration Database, open a command prompt window.
3. Change to <extractedfolder>\Tools.
4. Type BlackBerryDBRestore.exe.
5. Type the same parameters that you used when you backed up the BlackBerry Configuration Database.
6. Press ENTER.
Users experience unexpected behavior with message lists and calendars on BlackBerry devices

Possible cause
If the MAPI and CDO client version 6.5.8022 was installed without uninstalling previous versions of the MAPI and CDO client (including the associated .DLL files), users might experience unexpected behavior with message lists and calendars on BlackBerry devices.

Possible solution
For more information about Microsoft Exchange Server MAPI Client and CDO version 1.2.1, visit www.microsoft.com.

1. In the Windows Services, stop the services for the BlackBerry Enterprise Server and any processes that use the MAPI and CDO client.
2. Remove the MAPI and CDO client version 6.5.8022.
3. Verify that the following files are not present in C:\Windows\System32 or any other directory in the environment path:
   - CDO.DLL
   - EMSABP32.DLL
   - EMSMDB32.DLL
   - EMSUI32.DLL
   - EMSUIX32.DLL
   - GAPI32.DLL
   - MAPISP32.EXE
   - MSPST32.DLL
   - WMSUI32.DLL
4. In C:\Windows\System32, run the FixMapi.exe application.
5. Install the MAPI and CDO client version 6.5.8022.
6. Restart the services for the BlackBerry Enterprise Server and any processes that use the MAPI and CDO client.

If you run the BlackBerry Enterprise Server setup application after you complete the possible solution, when the setup application displays the preinstallation checklist, an error message indicates that the setup application could not detect
the MAPI and CDO client. The setup application displays this error message because you installed the MAPI and CDO client version 6.5.8022 in a different directory than the directory that you installed it in for previous versions. The error message does not prevent the BlackBerry Enterprise Server setup application from completing the installation process successfully.

## Some BlackBerry Enterprise Server components do not start

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Possible solution</th>
</tr>
</thead>
</table>
| The BlackBerry Administration Service, BlackBerry MDS Connection Service, or BlackBerry Collaboration Service is configured to use a dynamic port when it connects to the BlackBerry Configuration Database, but the database server uses a static port. | Configure a static port for the BlackBerry Configuration Database.  
1. On the computer that hosts the BlackBerry Enterprise Server component, on the taskbar, click **Start > All Programs > BlackBerry Enterprise Server**.  
2. Right-click **BlackBerry Server Configuration** and select **Run as administrator**.  
3. On the **Database Connectivity** tab, clear the **Use dynamic ports or specify SQL port** check box.  
4. In the **Use dynamic ports or specify SQL port** field, type the correct port number.  
5. Click **OK**.  
6. In the Windows Services, restart the services for the BlackBerry Enterprise Server component. |
| The BlackBerry Administration Service, BlackBerry MDS Connection Service, or BlackBerry Collaboration Service is configured to use an incorrect static port number when it connects to the BlackBerry Configuration Database. | Configure the component to use the correct port number.  
1. On the computer that hosts the BlackBerry Enterprise Server component, on the taskbar, click **Start > All Programs > BlackBerry Enterprise Server**.  
2. Right-click **BlackBerry Server Configuration** and select **Run as administrator**.  
3. On the **Database Connectivity** tab, clear the **Use dynamic ports or specify SQL port** check box.  
4. In the **Use dynamic ports or specify SQL port** field, type the correct port number.  
5. Click **OK**. |
You cannot access the BlackBerry Administration Service

Possible cause

The computer that hosts the BlackBerry Administration Service has more than one NIC and the production NIC is not first in the bind order in Windows network settings as it must be for you to access the BlackBerry Administration Service.

Possible solution

On the computer that hosts the BlackBerry Administration Service, in the Windows network settings, verify that the production NIC is first in the bind order. For more information, visit www.blackberry.com/btsc to read article KB18190.

You cannot create a user account in the BlackBerry Administration Service

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Possible solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The BlackBerry Administration Service is configured to use static ports when it connects to the BlackBerry Configuration Database server, but the BlackBerry Configuration Database server uses a dynamic port.</td>
<td>Configure the BlackBerry Administration Service to use a dynamic port for the BlackBerry Configuration Database.</td>
</tr>
</tbody>
</table>

1. On the computer that hosts the BlackBerry Enterprise Server component, on the taskbar, click Start > All Programs > BlackBerry Enterprise Server.  
2. Right-click BlackBerry Server Configuration and select Run as administrator.  
3. On the Database Connectivity tab, select the Use dynamic ports or specify SQL port check box.  
4. Click OK.
### Possible cause

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Possible solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>5. In the Windows Services, restart the services for the BlackBerry Administration Service.</td>
<td></td>
</tr>
</tbody>
</table>

### The BlackBerry Administration Service pool name is the same as the FQDN of the host computer

**Possible cause**

A DNS record was not created before a BlackBerry Administration Service instance was installed.

**Possible solution**

1. Create the DNS record for the BlackBerry Administration Service instance.
2. On the computer that hosts the BlackBerry Enterprise Server component, on the taskbar, click **Start > All Programs > BlackBerry Enterprise Server**.
3. Right-click **BlackBerry Server Configuration** and select **Run as administrator**.
4. On the **Administration Service - High Availability** tab, in the **Pool name** field, type the name of the BlackBerry Administration Service pool.
5. In the Windows Services, restart the services for the BlackBerry Administration Service.

### You cannot add users in the BlackBerry Administration Service after an upgrade to BlackBerry Enterprise Server 5.0 SP4

The setup application for BlackBerry Enterprise Server 5.0 SP4 for Microsoft Exchange enables LDAP for populating your organization’s directory. Previous versions of BlackBerry Enterprise Server used MAPI.
If a BlackBerry Enterprise Server instance exists in a child domain, users from the parent and parallel domains are not populated by default. When you attempt to add a user in the BlackBerry Administration Service using your organization’s directory after an upgrade to BlackBerry Enterprise Server 5.0 SP4, you may not be able to add the user and the following error message may appear: “No records were found that match the email address. Edit the email address and try again.”

Possible cause

The BlackBerry Enterprise Server setup application creates the following registry key in either HKEY_LOCAL_MACHINE\Software\Research In Motion\BlackBerry Enterprise Server\Agents or HKEY_LOCAL_MACHINE\Software\WOW6432Node\Research In Motion\BlackBerry Enterprise Server\Agents, depending on the version of Windows Server:

- Registry Key: LDAPSearch
- Data Type: DWORD (32 bit)
- Value: 1

In BlackBerry Enterprise Server 5.0 SP4, the Mailstore service uses LDAP instead of MAPI and the setup application changes the LDAPSearch registry value to 1 during an upgrade to BlackBerry Enterprise Server 5.0 SP4.

This LDAPSearch works for the default domain search, but in environments with multiple child domains the LDAPSearch may not work.

Possible solution

Disable the LDAPSearch on the BlackBerry Enterprise Server.

Document and back up the registry entries before you implement any changes.

1. On the computer that hosts the BlackBerry Enterprise Server, click Start > Run.
2. Type regedit and click OK. If the User Account Control dialog box appears, click Continue.
3. Navigate to the appropriate location (depending on the version of Windows Server):
   - HKEY_LOCAL_MACHINE\Software\Research In Motion\BlackBerry Enterprise Server\Agents
   - HKEY_LOCAL_MACHINE\Software\WOW6432Node\Research In Motion\BlackBerry Enterprise Server\Agents
4. Right-click on the Agents key in the left-hand pane and select Export.
5. Save the exported key in an accessible location in case it is needed for reference or rollback.
6. Set the LDAPSearch value to 0.
7. Restart the BlackBerry Controller service.

Possible solution

Create additional registry keys to take advantage of LDAP.

Document and back up the registry entries before you implement any changes.

1. On the computer that hosts the BlackBerry Enterprise Server, click Start > Run.
2. Type `regedit` and click OK. If the **User Account Control** dialog appears, click Continue.

3. Navigate to the appropriate location (depending on the version of Windows Server):
   - HKEY_LOCAL_MACHINE\Software\Research In Motion\BlackBerry Enterprise Server\Agents
   - HKEY_LOCAL_MACHINE\Software\WOW6432Node\Research In Motion\BlackBerry Enterprise Server\Agents

4. Right-click the **Agents** key in the left-hand pane and select **Export**.

5. Save the exported key in an accessible location in case it is needed for reference or rollback.

6. Create a LDAPDomain key:
   a. Right-click the **Agents** key in the left-hand pane and select **New > String Value**.
   b. Type LDAPDomain as the name.
   c. Right-click on LDAPDomain and select **Modify**.
   d. In the Value data field, type `<FQDN of Global Catalog Server>:3268`, for example childdomain.example.com:3268. Make sure you use a Global Catalog Server in the root domain (top level).

7. Create a LDAPBaseDN key.
   a. Right-click the **Agents** key in the left-hand pane and select **New > String Value**.
   b. Type LDAPBaseDN as the name.
   c. Right-click on LDAPBaseDN and select **Modify**.
   d. In the Value data field, type the distinguished name of the top level domain, for example DC=EXAMPLE,DC=COM.

8. Restart the BlackBerry Controller service.

9. Log in to the BlackBerry Administration Service.

10. Click **Refresh available user list from company directory**.
Related resources

To read the following guides or additional related material, visit http://www.blackberry.com/go/serverdocs.

<table>
<thead>
<tr>
<th>Guide</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>What’s New in BlackBerry Enterprise Server 5.0 SP4 Job Aid</td>
<td>• Summary of new features</td>
</tr>
<tr>
<td>BlackBerry Enterprise Server Update Guide</td>
<td>• Summary of updates to the administrator guides for BlackBerry Enterprise Server 5.0 SP4</td>
</tr>
<tr>
<td>BlackBerry Enterprise Server Release Notes</td>
<td>• Description of known issues and potential workarounds</td>
</tr>
</tbody>
</table>
| BlackBerry Enterprise Server Installation and Configuration Guide | • System requirements  
  • Installation instructions                     |
| BlackBerry Enterprise Server Policy Reference Guide | • Descriptions of available IT policy rules and application control policy rules  
  • Descriptions of Wi-Fi configuration settings and VPN configuration settings |
## Glossary

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AES</td>
<td>Advanced Encryption Standard</td>
</tr>
<tr>
<td>API</td>
<td>application programming interface</td>
</tr>
<tr>
<td>AJAX</td>
<td>Asynchronous JavaScript and XML</td>
</tr>
<tr>
<td>BlackBerry CAL</td>
<td>A BlackBerry Client Access License (BlackBerry CAL) limits how many users you can add to a BlackBerry Enterprise Server.</td>
</tr>
<tr>
<td>BlackBerry Domain</td>
<td>A BlackBerry Domain consists of the BlackBerry Configuration Database with its users and any BlackBerry Enterprise Server instances that connect to it.</td>
</tr>
<tr>
<td>BlackBerry MDS</td>
<td>BlackBerry Mobile Data System</td>
</tr>
<tr>
<td>CAS</td>
<td>Client Access Server</td>
</tr>
<tr>
<td>CDMA</td>
<td>Code Division Multiple Access</td>
</tr>
<tr>
<td>CDO</td>
<td>Collaboration Data Object</td>
</tr>
<tr>
<td>DMZ</td>
<td>A demilitarized zone (DMZ) is a neutral subnetwork outside of an organization's firewall. It exists between the trusted LAN of the organization and the untrusted external wireless network and public Internet.</td>
</tr>
<tr>
<td>DNS</td>
<td>Domain Name System</td>
</tr>
<tr>
<td>FQDN</td>
<td>fully qualified domain name</td>
</tr>
<tr>
<td>HTTP</td>
<td>Hypertext Transfer Protocol over Secure Sockets Layer</td>
</tr>
<tr>
<td>HTTPS</td>
<td>Hypertext Transfer Protocol over Secure Sockets Layer</td>
</tr>
<tr>
<td>IIS</td>
<td>Internet Information Services</td>
</tr>
<tr>
<td>IP</td>
<td>Internet Protocol</td>
</tr>
<tr>
<td>IP address</td>
<td>An Internet Protocol (IP) address is an identification number that each computer or mobile device uses when it sends or receives information over a network, such as the Internet. This identification number identifies the specific computer or mobile device on the network.</td>
</tr>
<tr>
<td>JDK</td>
<td>Java Development Kit</td>
</tr>
<tr>
<td>JRE</td>
<td>Java Runtime Environment</td>
</tr>
<tr>
<td>Acronym</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>LAN</td>
<td>A local area network (LAN) is a computer network shared by a group of computers in a small area, such as an office building. Any computer in this network can communicate with another computer that is part of the same network.</td>
</tr>
<tr>
<td>MAPI</td>
<td>Messaging Application Programming Interface</td>
</tr>
<tr>
<td>messaging server</td>
<td>A messaging server sends and processes messages and provides collaboration services, such as updating and communicating calendar and address book information.</td>
</tr>
<tr>
<td>MSDE</td>
<td>Microsoft SQL Server Desktop Engine</td>
</tr>
<tr>
<td>NIC</td>
<td>network interface card</td>
</tr>
<tr>
<td>NTLM</td>
<td>NT LAN Manager</td>
</tr>
<tr>
<td>RAID</td>
<td>redundant array of independent (or inexpensive) disks</td>
</tr>
<tr>
<td>SMS</td>
<td>Short Message Service</td>
</tr>
<tr>
<td>SNMP</td>
<td>Simple Network Management Protocol</td>
</tr>
<tr>
<td>SQL</td>
<td>Structured Query Language</td>
</tr>
<tr>
<td>SRP</td>
<td>Server Routing Protocol</td>
</tr>
<tr>
<td>SSL</td>
<td>Secure Sockets Layer</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Transmission Control Protocol/Internet Protocol (TCP/IP) is a set of communication protocols that is used to transmit data over networks, such as the Internet.</td>
</tr>
<tr>
<td>TCP</td>
<td>Transmission Control Protocol</td>
</tr>
<tr>
<td>TLS</td>
<td>Transport Layer Security</td>
</tr>
<tr>
<td>Triple DES</td>
<td>Triple Data Encryption Standard</td>
</tr>
<tr>
<td>UDP</td>
<td>User Datagram Protocol</td>
</tr>
<tr>
<td>VoIP</td>
<td>Voice over Internet Protocol</td>
</tr>
<tr>
<td>WAN</td>
<td>wide area network</td>
</tr>
<tr>
<td>XML</td>
<td>Extensible Markup Language</td>
</tr>
</tbody>
</table>
Legal notice

©2014 BlackBerry. All rights reserved. BlackBerry® and related trademarks, names, and logos are the property of BlackBerry Limited and are registered and/or used in the U.S. and countries around the world.

Safari is a trademark of Apple Inc. Google Chrome is a trademark of Google Inc. IBM, Lotus, and Sametime are trademarks of International Business Machines Corporation. Intel and Xeon are trademarks of Intel Corporation. Kerberos is a trademark of the Massachusetts Institute of Technology. Microsoft, Active Directory, ActiveX, Hyper-V, Internet Explorer, Lync, Outlook, SQL Server, Visual C++, Windows, Windows Media, Windows Server, and Windows Vista are trademarks of Microsoft Corporation. Mozilla and Firefox are trademarks of Mozilla Foundation. RSA is a trademark of RSA Security. Java, JavaScript, JDK, and JRE are trademarks of Oracle and/or its affiliates. VMware vSphere is a trademark of VMware, Inc. Wi-Fi is a trademark of the Wi-Fi Alliance. All other trademarks are the property of their respective owners.

This documentation including all documentation incorporated by reference herein such as documentation provided or made available at www.blackberry.com/go/docs is provided or made accessible "AS IS" and "AS AVAILABLE" and without condition, endorsement, guarantee, representation, or warranty of any kind by BlackBerry Limited and its affiliated companies ("BlackBerry") and BlackBerry assumes no responsibility for any typographical, technical, or other inaccuracies, errors, or omissions in this documentation. In order to protect BlackBerry proprietary and confidential information and/or trade secrets, this documentation may describe some aspects of BlackBerry technology in generalized terms. BlackBerry reserves the right to periodically change information that is contained in this documentation; however, BlackBerry makes no commitment to provide any such changes, updates, enhancements, or other additions to this documentation to you in a timely manner or at all.

This documentation might contain references to third-party sources of information, hardware or software, products or services including components and content such as content protected by copyright and/or third-party websites (collectively the "Third Party Products and Services"). BlackBerry does not control, and is not responsible for, any Third Party Products and Services including, without limitation the content, accuracy, copyright compliance, compatibility, performance, trustworthiness, legality, decency, links, or any other aspect of Third Party Products and Services. The inclusion of a reference to Third Party Products and Services in this documentation does not imply endorsement by BlackBerry of the Third Party Products and Services or the third party in any way.

EXCEPT TO THE EXTENT SPECIFICALLY PROHIBITED BY APPLICABLE LAW IN YOUR JURISDICTION, ALL CONDITIONS, ENDORSEMENTS, GUARANTEES, REPRESENTATIONS, OR WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY CONDITIONS, ENDORSEMENTS, GUARANTEES, REPRESENTATIONS OR WARRANTIES OF DURABILITY, FITNESS FOR A PARTICULAR PURPOSE OR USE, MERCHANTABILITY, MERCHANTABLE QUALITY, NON-INFRINGEMENT, SATISFACTORY QUALITY, OR TITLE, OR ARISING FROM A STATUTE OR CUSTOM OR A COURSE OF DEALING OR USAGE OF TRADE, OR RELATED TO THE DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES REFERENCED HEREIN, ARE HEREBY EXCLUDED. YOU MAY ALSO HAVE OTHER RIGHTS THAT VARY BY STATE OR PROVINCE. SOME JURISDICTIONS MAY NOT ALLOW THE EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES AND CONDITIONS. TO THE EXTENT PERMITTED BY LAW, ANY IMPLIED WARRANTIES OR CONDITIONS RELATING TO THE DOCUMENTATION TO THE EXTENT THEY CANNOT BE EXCLUDED AS SET OUT ABOVE, BUT CAN BE LIMITED, ARE
HEREBY LIMITED TO NINETY (90) DAYS FROM THE DATE YOU FIRST ACQUIRED THE DOCUMENTATION OR THE ITEM THAT IS THE SUBJECT OF THE CLAIM.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, IN NO EVENT SHALL BLACKBERRY BE LIABLE FOR ANY TYPE OF DAMAGES RELATED TO THIS DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES REFERENCED HEREIN INCLUDING WITHOUT LIMITATION ANY OF THE FOLLOWING DAMAGES: DIRECT, CONSEQUENTIAL, EXEMPLARY, INCIDENTAL, INDIRECT, SPECIAL, PUNITIVE, OR AGGRAVATED DAMAGES, DAMAGES FOR LOSS OF PROFITS OR REVENUES, FAILURE TO REALIZE ANY EXPECTED SAVINGS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, LOSS OF BUSINESS OPPORTUNITY, OR CORRUPTION OR LOSS OF DATA, FAILURES TO TRANSMIT OR RECEIVE ANY DATA, PROBLEMS ASSOCIATED WITH ANY APPLICATIONS USED IN CONJUNCTION WITH BLACKBERRY PRODUCTS OR SERVICES, DOWNTIME COSTS, LOSS OF THE USE OF BLACKBERRY PRODUCTS OR SERVICES OR ANY PORTION THEREOF OR OF ANY AIRTIME SERVICES, COST OF SUBSTITUTE GOODS, COSTS OF COVER, FACILITIES OR SERVICES, COST OF CAPITAL, OR OTHER SIMILAR PECUNIARY LOSSES, WHETHER OR NOT SUCH DAMAGES WERE FORESEEN OR UNFORESEEN, AND EVEN IF BLACKBERRY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, BLACKBERRY SHALL HAVE NO OTHER OBLIGATION, DUTY, OR LIABILITY WHATSOEVER IN CONTRACT, TORT, OR OTHERWISE TO YOU INCLUDING ANY LIABILITY FOR NEGLIGENCE OR STRICT LIABILITY.

THE LIMITATIONS, EXCLUSIONS, AND DISCLAIMERS HEREIN SHALL APPLY: (A) IRRESPECTIVE OF THE NATURE OF THE CAUSE OF ACTION, DEMAND, OR ACTION BY YOU INCLUDING BUT NOT LIMITED TO BREACH OF CONTRACT, NEGLIGENCE, TORT, STRICT LIABILITY OR ANY OTHER LEGAL THEORY AND SHALL SURVIVE A FUNDAMENTAL BREACH OR BREACHES OR THE FAILURE OF THE ESSENTIAL PURPOSE OF THIS AGREEMENT OR OF ANY REMEDY CONTAINED HEREIN; AND (B) TO BLACKBERRY AND ITS AFFILIATED COMPANIES, THEIR SUCCESSORS, ASSIGNS, AGENTS, SUPPLIERS (INCLUDING AIRTIME SERVICE PROVIDERS), AUTHORIZED BLACKBERRY DISTRIBUTORS (ALSO INCLUDING AIRTIME SERVICE PROVIDERS) AND THEIR RESPECTIVE DIRECTORS, EMPLOYEES, AND INDEPENDENT CONTRACTORS.

IN ADDITION TO THE LIMITATIONS AND EXCLUSIONS SET OUT ABOVE, IN NO EVENT SHALL ANY DIRECTOR, EMPLOYEE, AGENT, DISTRIBUTOR, SUPPLIER, INDEPENDENT CONTRACTOR OF BLACKBERRY OR ANY AFFILIATES OF BLACKBERRY HAVE ANY LIABILITY ARISING FROM OR RELATED TO THE DOCUMENTATION.

Prior to subscribing for, installing, or using any Third Party Products and Services, it is your responsibility to ensure that your airtime service provider has agreed to support all of their features. Some airtime service providers might not offer Internet browsing functionality with a subscription to the BlackBerry® Internet Service. Check with your service provider for availability, roaming arrangements, service plans and features. Installation or use of Third Party Products and Services with BlackBerry’s products and services may require one or more patent, trademark, copyright, or other licenses in order to avoid infringement or violation of third party rights. You are solely responsible for determining whether to use Third Party Products and Services and if any third party licenses are required to do so. If required you are responsible for acquiring them. You should not install or use Third Party Products and Services until all necessary licenses have been acquired. Any Third Party Products and Services that are provided with BlackBerry’s products and services are provided as a convenience to you and are provided “AS IS” with no express or implied conditions, endorsements, guarantees, representations, or warranties of any kind by BlackBerry and BlackBerry assumes no liability whatsoever, in relation thereto. Your use of Third Party Products and Services shall be governed by and subject to you agreeing to the terms of
separate licenses and other agreements applicable thereto with third parties, except to the extent expressly covered by a license or other agreement with BlackBerry.

Certain features outlined in this documentation require a minimum version of BlackBerry Enterprise Server, BlackBerry Desktop Software, and/or BlackBerry Device Software.

The terms of use of any BlackBerry product or service are set out in a separate license or other agreement with BlackBerry applicable thereto. NOTHING IN THIS DOCUMENTATION IS INTENDED TO SUPERSEDE ANY EXPRESS WRITTEN AGREEMENTS OR WARRANTIES PROVIDED BY BLACKBERRY FOR PORTIONS OF ANY BLACKBERRY PRODUCT OR SERVICE OTHER THAN THIS DOCUMENTATION.

Certain features outlined in this documentation might require additional development or Third Party Products and Services for access to corporate applications.


This product includes software developed by the Apache Software Foundation (www.apache.org/) and/or is licensed pursuant to one of the licenses listed at (www.apache.org/licenses/). For more information, see the NOTICE.txt file included with the software.

BlackBerry Limited
2200 University Avenue East
Waterloo, Ontario
Canada N2K 0A7

BlackBerry UK Limited
200 Bath Road
Slough, Berkshire SL1 3XE
United Kingdom

Published in Canada